GIS based analysis for planning school locations

A USER MANUAL

Prepared by Dr Bruno Parolin, International School Mapping and GIS Specialist

DRAFT

3 March 2016
Version 4
# Table of Contents

## Part A: Generic GIS Analysis

1. Part A Introduction
   1.1 Why GIS as a planning tool in education?  
   1.2 The GIS Functionality Matrix  
2. Base GIS layers and non-spatial data requirements  
3. Generic GIS steps for analysis of questions
   3.1 What patterns emerge in the distribution of schools of different type, but especially in government secondary schools?  
   3.2 What is the distribution of the school age population or secondary school age Population, (persons aged 14-15, for different spatial units (e.g. village boundaries or census boundaries))?  
   3.3 Is there a pattern of co-location of schools of different types in areas?  
   3.4 Which UDISE indicators should be used to map aspects of inefficiency in the secondary school system?  
   3.5 How to determine the catchment areas for schools of a certain size and distance norm?  
   3.6 How to determine the spacing of secondary schools or of other school types using accepted distance norms (e.g. 5 km for secondary schools)? Can one easily measure the point to point distances between schools of different type?  
   3.7 How many secondary schools (along with their locations) would be needed if plans are developed using school planning norms and what would be their respective school size over next 5-10 years?  
   3.8 What is the optimum location of new schools of various sizes and their optimum allocations of demand points (villages) to these schools using distance minimization and maximum population coverage criteria?  
   3.9 What are the implications of relaxing distance norms and using school size criteria to determine school location?  
   3.10 How many schools are located close by the optimum locations of new schools and what is the locational significance of these nearby schools?  
   3.11 How to assess the accessibility characteristics of each optimum location solution to determine the best outcome for the education system?  
   3.12 How can low enrolment secondary schools be rationalized through mergers or closures?  
   3.13 How can GIS information be used to optimize school resourcing for ensuring maximum efficiency?  

## Part B: Case Study - GIS for Planning New School Locations

4. Part B Introduction
   4.1 Why use ArcGIS?  
5. Base GIS layers

---

**ii | Page**
6. Inputting GIS layers into ArcMap and saving a map 42
7. Generating a layer of village centroids 51
8. Generating a network dataset 58
9. Using network analyst for location-allocation analysis 65
   9.1 Preparing your display 65
   9.2 Creating the location-allocation layer 66
   9.3 Adding candidate facilities 68
   9.4 Adding demand points 71
   9.5 Adding physical barrier (polygon) constraints 73
   9.6 Setting up the properties of the location-allocation analysis 73
   9.7 Run the process to determine 23 optimum school locations 76
   9.8 Determine the existing schools located within proximity of the optimum location of new schools 80
10. Generating statistical output – accessibility characteristics 84
    10.1 Average distance and maximum distance 85
    10.2 Person-kilometers travelled 86
    10.3 Percent of persons aged 14-15 covered by the solution 86
    10.4 Average number of villages per catchment area 87
    10.5 Average number of persons aged 14-15 per catchment area 88
    10.6 Average population of villages per catchment area 88
    10.7 Average population density per catchment area 90
    10.8 Average size of catchment area 90
    10.9 Villages not allocated to an optimum facility 91
11. Generating a layout and exported map 92
References 97
APPENDIX 1: Procedure to Download and Install a Trail Version of ArcGIS 10.3.1 98
GIS based analysis for planning school locations

PART A: Generic GIS analysis
1. Part A: Introduction

The purpose of this Manual is to assist planners and decision makers to address problems of inefficiency in the secondary education system in India through the use of Geographical Information Systems (GIS). Some key issues are presented that are likely to affect the secondary education system at district, state and national levels. These issues can be found in rural as well as urban areas, although the intensity of the issues and their nature may be somewhat different in rural as opposed to urban areas.

In working with education data to understand the geographic characteristics of inefficiency in the education system in Meghalaya state, Assam state and, more intensively, in Baksa district of Assam state, the consultant has identified four major issues that could be addressed by education planners and decision makers alike, and that are likely to be found in other states of India as well:

- Dispersed population and dispersed schools – inadequate catchment area size to support sustained enrolments in schools
- Population is present but there are no schools present, or schools may be located beyond a threshold of reasonable distance for travel to school
- Too many small sized schools that are closely spaced – overlapping catchment areas where there is inadequate population to support sustained enrolments across all schools
- Overcrowding in schools where low enrolment schools can be located close by.

The above issues are more likely to affect rural areas of districts, states and across the nation. In an urban area context, there may also be problems of poor location of secondary schools that affects catchment areas and travel distance (accessibility) but there are also likely to be problems of inadequate numbers of schools due to scarcity of land supply and overcrowding in existing schools. In either setting, the planner and decision maker would be required to assess the situation by collecting all relevant data (UDISE, Census data, or both), undertaking appropriate analyses and, finally, making a decision that would, hopefully, lead to a reduced level of inefficiency and better allocation of education resources.

It should be stressed that the Manual is not about enabling school planners and decision makers to necessarily build new secondary schools unless they are absolutely required. This may be the case in some high density and rapidly growing urban centers but, more generally, the problem in India is too many small schools that are too closely spaced together. Our objective is to present a series of steps and methods that are GIS based that allow one to examine these issues of inefficiency in a systematic way in order to generate informed decision making in the education sector. Inefficiency in the secondary education system is associated with a geographic footprint, and the best way to understand this footprint and suggest alternatives is to utilize GIS technology and methods.

Given the above problems the following questions can be posed for which GIS concepts and methods can then be used to undertake the necessary analyses:

1. What patterns emerge in the distribution of schools of different type, but especially government secondary schools? Are there patterns of dispersal and clustering evident? Are there geographic or spatial factors that may explain the visualized patterns?

2. What is the distribution of the school age population or secondary school age population (persons aged 14-15) for different spatial units (e.g. village boundaries or census boundaries)?

3. Is there a pattern of co-location of schools of different types in areas?

4. Which UDISE indicators should be used to map aspects of inefficiency in the secondary school system?
5. How to determine the catchment areas for schools of a certain size and distance norm?

6. How to determine the spacing of secondary schools or of other school types using accepted distance norms (e.g., 5 km for secondary schools)? Can one easily measure the point to point distances between schools of different type?

7. How many secondary schools (along with their locations) would be needed if plans are developed using school planning norms and what would be their respective school size over next 5-10 years?

8. What is the optimum location of new schools of various sizes and their optimum allocations of demand points (villages) to these schools using distance minimization and maximum population coverage criteria?

9. What are the implications of relaxing distance norms and using school size criteria to determine school location?

10. How many schools are located close by the optimum locations of new schools and what is the locational significance of these nearby schools?

11. How to assess the accessibility characteristics of each optimum location solution to determine the best outcome for the education system?

12. How can low enrolment secondary schools be rationalized through mergers or closures?

13. How can GIS information be used to optimize school resourcing for ensuring maximum efficiency?

Before proceeding to understand the range of GIS analyses and functionality that could be undertaken to examine each of the above questions, it is important to understand the role and importance of GIS in education resources planning and management.

1.1 Why GIS as a planning tool in education?

Among the possibilities for GIS to improve education planning at either the micro level of macro level, the following are identified by Attfield et.al (2002, pp. 10-12):

- GIS helps make the presentation of data more attractive than traditional static maps
- Projecting tabular data onto maps helps in recognizing “unexpected” situations that will require closer examination when they are noticed
- Through considering geographical (spatial) factors, the analysis becomes “finer” and more precise, increasing the likelihood that ensuing strategies will be more relevant
- More flexible assistance can be provided in prospective planning at multiple levels of analysis: national, state, district, and local.

From the above list of benefits of utilizing GIS for planning in the education sector, it is clear that understanding the capabilities of GIS is fundamental in being able to plan how best to use the technology to support needs in the education sector. Therefore, the starting point is developing an understanding of what GIS technology is able to achieve and deliver to the school planners and decision makers in the education sector.

It is possible to categorize GIS functionality into a number of broad groups, as shown in Figure 1, and described below. These broader GIS functions are common in the way GIS is used in the education sector but in other sectors as well.

In going from left to right in Figure 1, there is an increase in the so-called GIS Value Chain – a progression from more simple to more complex and higher value use of GIS. Discussion of the following broad groups of GIS functionality is taken from Exprodat (2013).
Data organization
This is the ‘building of a GIS’, whereby spatial and geographic information about the education system is collated from a wide variety of sources and organized into a logical spatial data infrastructure. Data may be received in a variety of spatial (SDE, shapefile, file geodatabase, CAD, TAB, etc.) and non-spatial (UDISE, Census, Excel, PDF) formats.

Visualization
One of the main strengths of GIS technology is that it allows the school planner or decision maker to view data from a wide variety of data sources at the same time, often in a single map view. Spatial data sources can be overlaid on one another and data integration can help identify patterns in the data.

Data query
GIS applications provide a wide range of data query tools, to enable the user to find data of interest. Simple GIS data search tools are capable of finding items using attributes (e.g. schools with no electricity), location (e.g. schools within a village boundary) and proximity (e.g. schools within 2 km of each other). Both raster and vector data can be queried, allowing the GIS user to interrogate all datasets if required.

Data editing
Data viewed in a GIS can be edited, both in terms of its geographic component and its underlying attributes. In addition, GIS technology enables users to create completely new data, e.g. by drawing directly on to the map or by extracting co-ordinate data from existing layers in order to create new layers (e.g. creating points – centroids - to represent village boundaries).
Spatial analysis

The GIS map is aware of the location of all items on the map, including their spatial relationship to all the other items on the map. For this reason GIS software is able to run a unique array of spatial analyses between layers. Examples include calculating distances and areas of features, generating buffers around points (schools) lines (roads) and areas (village boundaries), performing deterministic and geostatistical analysis on layers, and network analysis (optimum location-allocation analysis, service areas). These tools help to identify patterns in the data that would most likely not have been seen without the use of a GIS.

Geoprocessing

GIS provides an array of tools for manipulating spatial data, ranging from converting between data formats and re-projecting co-ordinates, through surface analysis to satellite image processing. Many GIS tools allow such processing workflows to be grouped into models and saved for re-use, allowing complex data processing to be easily repeated, ensuring that modelling procedures can be standardized or run iteratively.

Prediction

Using a combination of the functions described above, GIS can be used to predict favorable locations, based on vast amounts of data and multiple factors. Such ‘Data Mining’ can be defined as “the nontrivial extraction of implicit, previously unknown, and potentially useful information from data” and also “the science of extracting useful information from large data sets or databases”. For example, a site location model could be specified in the GIS that evaluates potential sites for a school location based on a variety of factors such as access to utilities, steepness of the land, distance to center of village, availability of nearby teachers etc.

Table 1 indicates the range of questions that school planners and decision makers can ask using GIS and their relationship to generic GIS type functions and analyses. Most of the questions would involve the use of GIS for spatial analysis and mapping tasks, where databases, such as UDISE, are analysed geographically and results visualized in map form. The generic steps for GIS analysis associated with each question are given in Section 3.2.

1.2 The GIS software functionality matrix

Table 2 presents a selection of the major types of GIS software (columns) and types of GIS analyses (rows) that can be undertaken to examine the various questions. The GIS software has been divided into three types: open source and free availability; desktop GIS packages that require some form of one-off or annual license, and; a geographic program (FlowMap) that is specifically written for accessibility, location-allocation and flow analysis. It is not a full blown GIS and has limited visualization options compared to desktop GIS packages. FlowMap is free for small networks but requires a Professional Edition for networks exceeding a certain number of nodes and lines (approx. €500).

Table 2 is not comprehensive by any means and potential users of GIS for educational planning purposes are encouraged to search the internet for GIS resources. For an excellent overview of other GIS software being used by the GIS industry the reader is referred to:

http://gisgeography.com/mapping-out-gis-software-landscape/

Many of the GIS software packages shown in Table 2 have been observed by the consultant to be in use in various Ministries of Education around the world, normally within a GIS Unit or within an Education Planning department. Each piece of GIS software has particular advantages for the types of questions that could be examined by planners and decision makers alike. The advantages and disadvantages of each are briefly discussed in relation to the GIS analyses required for the education sector.
Table 1. Research questions and relationship to generic GIS functions/analyses

<table>
<thead>
<tr>
<th>Questions</th>
<th>Generic GIS functions/analyses</th>
</tr>
</thead>
<tbody>
<tr>
<td>What patterns emerge in the distribution of schools of different type, but especially government secondary schools?</td>
<td>Aerial distance calculations; buffer analysis; visualisation; mapping</td>
</tr>
<tr>
<td>What is the distribution of the school age population or secondary school age population (persons aged 14-15) for different spatial units (e.g. village boundaries or census boundaries)?</td>
<td>Joining of spatial and non-spatial data; generate new attributes; population density mapping</td>
</tr>
<tr>
<td>Is there a pattern of co-location of schools of different type in areas?</td>
<td>Buffer analysis; mapping of school attributes and school location</td>
</tr>
<tr>
<td>Which UDISE indicators should be used to map aspects of inefficiency in the secondary school system?</td>
<td>Generation of new indicators; visualization</td>
</tr>
<tr>
<td>How to determine the catchment areas for schools of a certain size and distance norm?</td>
<td>Catchment area analysis - Thiessen (Voronoi) polygons; visualisation</td>
</tr>
<tr>
<td>How to determine the spacing of secondary schools or of other school types using accepted distance norms (e.g. 5 km for secondary schools)?</td>
<td>Buffer analysis; overlay and intersect; visualisation</td>
</tr>
<tr>
<td>How many secondary schools (along with their locations) would be needed if plans are developed using school planning norms and what would be their respective school size over next 5-10 years?</td>
<td>Generation of new layers; data editing; spatial analysis; visualization</td>
</tr>
<tr>
<td>What is the optimum location of new schools of various sizes and their optimum allocations of demand points (villages) to these schools using distance minimization and maximum population coverage criteria?</td>
<td>Location-allocation analysis; visualization; mapping of attributes</td>
</tr>
<tr>
<td>What are the implications of relaxing distance norms and using school size criteria to determine school location?</td>
<td>Location-allocation analysis with distance constraints; visualization; mapping of attributes</td>
</tr>
<tr>
<td>How many schools are located close by the optimum locations of new schools and what is the locational significance of these nearby schools?</td>
<td>Overlay and intersection analysis; aerial distance calculations</td>
</tr>
<tr>
<td>How to assess the accessibility characteristics of each optimum location solution to determine the best outcome for the education system?</td>
<td>Service area analysis; accessibility analysis; generate new attributes; visualization</td>
</tr>
<tr>
<td>How can low enrolment secondary schools be rationalized through mergers or closures?</td>
<td>Buffer analysis; visualisation</td>
</tr>
<tr>
<td>How can GIS information be used to optimize school resourcing for ensuring maximum efficiency?</td>
<td>Visualisation; mapping of attributes</td>
</tr>
<tr>
<td>Types of GIS Analyses and Generic GIS Functionality</td>
<td>Open Source/Free</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>QGIS v2.12.3 With GRASS GIS plus Add-ons</td>
</tr>
<tr>
<td>Catchment area analysis; Thiessen (Voronoi) polygons</td>
<td>✓</td>
</tr>
<tr>
<td>Population density mapping</td>
<td>✓</td>
</tr>
<tr>
<td>Mapping of school attributes</td>
<td>✓</td>
</tr>
<tr>
<td>Aerial distance calculations</td>
<td>✓</td>
</tr>
<tr>
<td>Overlay and intersection analysis (e.g. point in polygon)</td>
<td>✓</td>
</tr>
<tr>
<td>Generate new layers</td>
<td>✓</td>
</tr>
<tr>
<td>Optimum location-allocation analysis</td>
<td>Limited</td>
</tr>
<tr>
<td>Service areas analysis / accessibility analysis</td>
<td>✓</td>
</tr>
<tr>
<td>Buffer analysis</td>
<td>✓</td>
</tr>
<tr>
<td>Visualization/mapping</td>
<td>✓</td>
</tr>
<tr>
<td>Joining spatial and non-spatial data</td>
<td>✓</td>
</tr>
<tr>
<td>Editing of data</td>
<td>✓</td>
</tr>
</tbody>
</table>
The various Desktop GIS packages shown in Table 2 range in price from $US695 for Maptitude to $US23000 for ArcGIS (including the Network Analyst extension). However, not all GIS are the same and as can be seen from the table, several have limitations in the extent of their ability to perform particular GIS functions – normally this means that there are restrictions on the procedure as programmed in the GIS. Some of the limitations and restrictions could be overcome with specialized programming as most of these packages come with their own programming language.

Supermap and ArcGIS both require the Network Analyst extension in order to perform optimal location and allocation analysis. In the case of SuperMap there is a more limited array of locational analyses as compared to ArcGIS. Transcad also performs optimum location-allocation analysis but is limited in the types of criteria that can be used. FlowMap requires more specialized knowledge of location-allocation analysis and has outdated visualization and editing capabilities when compared to the open source GIS software and to the Desktop GIS packages.

The most widely used and easy to learn open source GIS package is QGIS. Grass GIS, a separate open source and free GIS package, can be added to the functionality of QGIS, especially for the network and location analyses. However, these are restricted in comparison to the range of analyses that can be completed with ArcGIS Network Analyst. All the same, as free software, QGIS represents excellent value and is a full-featured GIS with excellent visualization capabilities. As an open source package, QGIS is continually being updated with additional functionality by the opens source community. This means that version updates occur on a monthly basis and the user is required to keep abreast of these updates.

MapInfo is also a popular package but is limited in its range of spatial analyses as compared to Transcad, SuperMap and ArcGIS. It is used extensively in local and state government departments around the world and also by private enterprise, especially for the location analytics capabilities. At present, it is not possible to undertake optimum location-allocation analysis with Mapinfo, but it is certainly possible to create and visualize networks of different types using the software.

Geomedia GIS is a relatively new comer to the GIS field and is used extensively by the utility industries given the ability of the software to edit and update networks. However, the software is excellent for GIS work and processing but does not have features to undertake optimum location-allocation analyses.

ArcGIS with all extensions is referred to as industrial strength GIS. It has a long history of development dating back to the 1980s and has been a mainstay in academia for teaching and research. However, it is very widely used at all levels in the public sector around the world and also extensively used by private companies. Its advantages are the strength of GIS functionality, automation of workflows, high-end complex geoprocessing analyses and tasks. As a result it is commonly found in Ministries of Education, not only in the Education Planning departments but also in the Building and Maintenance departments and most other departments as well. It is the ability of ArcGIS to integrate most major databases found in a Ministry of Education that has been a strong appeal for its success.

Google Maps was not included in Table 2 as this service is not considered a GIS, although it is very widely used in the public sector around the world – including Ministries of Education. The main advantage of Google Maps is the visualization capacity and some limited but important travel type analytics. It does not have the range of GIS functionality shown in Table 2, but most public sectors users output layers from their respective GIS for input and visualization in Google Maps.

Part B of the GIS User Manual uses ArcGIS with Network Analyst extension for several of the questions in Table 1 that are related to optimum location-allocation analyses. A separate justification of the use of ArcGIS is provided in Part B.
2. Base GIS layers and non-spatial data requirements

With the exception of questions 8, 9, 11 and 12, all other questions and their associated GIS analyses require the school planners and decision makers to have access to the following GIS layers in Shape (SHP) file format. A GIS layer in SHP format is an international standard for the storage of geographic and database information related to point, line or area features. It is used extensively by all the Desktop GIS shown in Table 2, and is also read by QGIS and Flowmap. (The Base GIS layers required for analysis of questions 8, 9, 11 and 12 are discussed in Part B of the manual).

All GIS layers used in this part of the manual can be located on any directory, and on any drive on a local computer or computer network. In this case, whatever GIS package is to be used will need to be pointed in the direction of the drive and folder containing the GIS layers.

**Base layers (Shape files):**

- **Govt_Sec_Schools**

This GIS layer is composed of the geographic locations of all government secondary schools in a particular district(s) or state(s) that the user is investigating together with the corresponding UDISE 2013-2014 attributes of the schools. It is the result of joining spatial and non-spatial data - the attribute table of the school locations (spatial data) with the attribute table of the UDISE file using the SCHCD (School ID) attribute as the common attribute for the join (non-spatial data).

The following general steps would be used to undertake a table join using a GIS:

**Step 1:** Obtain the geographic coordinates (longitude and latitude) of all schools for the area of interest together with the unique School ID number for every school (usually an Excel file)

**Step 2:** Obtain the corresponding UDISE data file for all schools for the particular area of interest (usually an Excel file) together with the unique School ID number

**Step 3:** Import the Excel file of school locations into the GIS and create a new layer of school locations. Save the layer as a SHP file

**Step 4:** Open the Table Join procedure, or equivalent procedure, in the GIS and perform a table join between the SHP file of school locations and the corresponding Excel file containing the UDISE data for the schools using the common School ID attribute

**Step 5:** Save the layer and the table join for future analyses or mapping of any attribute from the UDISE data.

Please note that the UDISE file may contain all schools for the particular area of interest. In this case, one could use Excel to separate out only the Government secondary schools if that is the type of school required for analysis. Then the above steps would be followed.

- **Census Village Boundaries and associated population data**

A GIS layer of 2011 census village boundaries and their associated population data could be obtained from the corresponding Directorate of Census Operations in a particular state or from Census of India. This type of GIS data is available for every village in every district throughout India. The corresponding SHP file should be in a longitude or latitude geographic coordinate system.

The following general steps would be required to import or open the GIS SHP file into the GIS:

**Step 1:** Import or Open the SHP file in the same session where the schools’ GIS layer is located
Step 2: Overlay the schools for the particular area of interest (usually an Excel file) onto the census village boundary layer.

Step 3: Save the resulting map as a map file in the working directory.

- **State Boundary(s)**

A State boundary file(s) can be obtained as a GIS layer from the Census of India or from the Directorate of Census Operations. The State boundary layer serves to provide context for the GIS analyses and enables results to be mapped at the state level. The corresponding SHP file should be in a longitude or latitude geographic coordinate system.

The following general steps would be required to import or open the GIS SHP file into the GIS:

**Step 1:** Import or Open the SHP file in the same session where the schools’ GIS layer is located.

**Step 2:** Overlay the state boundary layer onto the layer of schools and census village boundaries.

**Step 3:** Save the resulting map as a map file in the working directory.

- **District Boundaries**

A particular district boundary GIS layer or the full set of districts within a state as a GIS layer can also be obtained from the Census of India or from the Directorate of Census Operations. The district boundary layer serves to provide context for the GIS analyses and enables results to be mapped at the district level, especially if this is the spatial unit of interest. The corresponding SHP file should be in a longitude or latitude geographic coordinate system.

The following general steps would be required to import or open the GIS SHP file into the GIS:

**Step 1:** Import or Open the SHP file in the same session where the schools’ GIS layer is located.

**Step 2:** Overlay the district boundary layer onto the layer of schools, census village boundaries and state boundary.

**Step 3:** Save the resulting map as a map file in the working directory.

- **Roads**

For the types of GIS analyses outlined in Table 2, and in the functionality matrix (except questions 8, 9, 11 and 12), a more general main road layer would be useful as background and context for the particular spatial scale of analysis to be undertaken using GIS. Normally, a main roads GIS layer would be available from the state geographic center, but can also be made available from the Census of India. There are also commercial providers of road and other GIS layers in India such as MapInfo India that provide GIS layers for a cost. The corresponding SHP file should be in a longitude or latitude geographic coordinate system.

The following general steps would be required to import or open the GIS SHP file into the GIS:

**Step 1:** Import or Open the SHP file in the same session where the schools’ GIS layer is located.

**Step 2:** Overlay the road layer onto the layer of schools, census village boundaries, district boundary(s) and state boundary.

**Step 3:** Save the resulting map as a map file in the working directory.

- **OpenStreetMap or other background layers**

One additional GIS base layer that is useful as a background layer to provide context for other GIS layers is the OpenStreetMap layer. This is an open source GIS layer available for free and can be accessed from within all of the Desktop GIS software shown in Table 3 and also with QGIS. The GIS software companies provide free GIS layers (e.g. OpenStreetMap, satellite
imagery, topographic layers, roads, digital elevation models etc.) that are available on the server location (cloud based services) provided by the particular software.

Below is an example of a map (Figure 2) that would be generated if most of the above base GIS layers were available and opened in QGIS or any of the desktop GIS packages shown in Table 3 (the only layer not added to the map is the census village layer, which is only available for Baksa district). The state of Assam has been used in this example, together with the distribution of government secondary schools. The background GIS layers are OpenStreetMap and a satellite image.

3. Generic GIS steps for analysis of questions

3.1 What patterns emerge in the distribution of schools of different type, but especially government secondary schools? Are there patterns of dispersal and clustering evident? Are there geographic or spatial factors that may explain the visualized patterns?

GIS layers required:
- All schools (X and Y coordinates), or Government secondary schools
- State, district or census village boundaries as applicable
- Roads
- Background layers as required: OpenStreetMap and/or satellite imagery, topography

The following general steps would be used:

Step 1: In the GIS, open the layer of schools, boundaries, roads and background layers

Step 2: Alter the symbology for the schools layer to have the GIS show different symbols for the different major types of government schools; primary, primary with upper primary, upper primary, secondary only, upper primary with secondary, upper primary with secondary and higher secondary and secondary with higher secondary.

Step 3: Examine the map for the extent of clustering of schools or dispersal of schools around population centers.

Step 4: Prior to undertaking Step 5, convert the coordinate system of the GIS layer of schools from latitude/longitude to a projected coordinate system which uses meters. This will ensure that distance calculations are correct.

Step 5: Use the relevant GIS tool to calculate distances between the different types of government schools; for example, distances between secondary and primary schools, secondary and upper primary schools and secondary and upper primary with secondary schools, etc. Generate a table of the results.

Step 6: Save the map in a map folder on the working directory.

Value added by use of GIS: The spatial distribution of the different government schools and their distance measurements provides visual and quantitative evidence of whether the schools are too close to each other or too far apart from each other. The distance measurements are also indicative of the efficiency/inefficiency of likely catchment areas and of whether school planning norms have been adhered to.

Figure 3 provides an example of the type of map that could be generated from the above GIS procedures. In this case the district of Baksa in Assam state is the area of interest.
Figure 2. Map of Assam state with multiple GIS layers
Figure 3. Distribution of government schools in Baksa district
3.2 What is the distribution of the school age population or secondary school age population (persons aged 14-15) for different spatial units (e.g. village boundaries or census boundaries)?

GIS layers required:

- All schools (X and Y coordinates), or Government secondary schools
- State, district or census village boundaries as applicable, plus the population attributes of the census village boundaries
- Roads
- Background layers as required: OpenStreetMap and/or satellite imagery, topography

The following general steps would be used:

**Step 1:** In the GIS, open the layer of schools, boundaries, roads and background layers.

**Step 2:** Use the GIS to join the census village boundary file to the associated population data file for each village.

**Step 3:** Go to the relevant Symbology window to select the appropriate attribute of population from the census village boundary layer.

**Step 4:** Select an appropriate graduated color theme for the population attribute and a classification method by which the GIS will generate classes and class ranges for the population attribute. There are normally several options available for how the classes of the population attribute are to be mapped with each one generating different outcomes. Test several of these methods and compare output before deciding on an appropriate method for your data. Normally the Help facility will explain the differences between the various methods.

**Step 5:** Generate a map of the distribution of schools age population for the spatial units of interest – census village boundaries in this case.

**Step 6:** Examine the distribution of secondary school age population.

**Step 7:** Add the GIS layer of schools or secondary schools to the map. Use the symbology feature in the GIS to also map the distribution of schools by enrolment size. One can also generate a new attribute called ‘Enrolment’ such that for each school the value of the corresponding value of enrolment size within a range.

**Step 8:** Observe the juxtaposition of secondary schools and their enrolment size relative to the distribution of school age population. Is there correspondence between the two layers or discordance between the two layers?

**Step 9:** One can also generate the density of schools age population for each spatial unit. First, convert the coordinate system of the GIS layer census village boundaries from latitude/longitude to a projected coordinate system which uses meters. This will ensure that area and density calculations are correct.

**Step 10:** Generate a new attribute in the attribute table of census village boundaries and call it ‘Pop_Den’ or population density.

**Step 11:** Use the geometry features of the GIS to calculate the correct areas of each village boundary (polygon) and place the result in a new attribute called ‘Area’.

**Step 12:** Go to the Pop_Den attribute and have the GIS calculate population density using the formula: population/area. Place the results in the Pop_Den attribute field.
Step 13: Use the symbology feature to map the distribution of school age population density relative to the location of schools.

Step 14: Save the map in a map folder on the working directory.

Value added by use of GIS: The spatial distribution of demand for government schools via mapping of the secondary school aged population and its comparison to the distribution of schools enables school planners and decision makers to directly assess the three of the four key problems mentioned in the introduction. In essence it allows one to assess where there is demand and no schools, or too few schools, and where there are too many schools closely spaced and not enough demand to support them.

Figure 4 provides an example of the type of map that could be generated from the above GIS procedures (except for population density). In this case the district of Baksa in Assam state is the area of interest.

3.3 Is there a pattern of co-location of schools of different types in areas?

GIS layers required:

- All schools (X and Y coordinates), or Government secondary schools
- State, district or census village boundaries as applicable
- Roads
- Background layers as required: OpenStreetMap and/or satellite imagery, topography

The following general steps would be used:

Step 1: In the GIS, open the layer of schools, boundaries, roads and background layers

Step 2: Alter the symbology for the schools layer to have the GIS show different symbols for the different major types of government schools; primary, primary with upper primary, upper primary, secondary only, upper primary with secondary, upper primary with secondary and higher secondary and secondary with higher secondary.

Step 3: Use the zoom feature in the GIS to focus on a more detailed area so that the extent of locational arrangement of schools can be better observed.

Step 4: Use the road layer or OpenStreetMap layer to measure distances between primary and upper primary and secondary schools.

Step 5: Save the map in a map folder on the working directory.

Value added by use of GIS: The zoomed in view of the locations of school types could be used to reveal the extent of co-location of schools in an area. In the example map (Figure 5) many primary, upper primary and secondary schools are located in very close proximity of each other, usually within a 1 km distance. Many secondary only schools are located next to an upper primary school. One interpretation of the pattern in Figure 5 is that the 5 kilometre distance norm does not appear to have been applied in the historical pattern of locating secondary schools. The very close distances in terms of co-location also suggest that could possibly be rationalized and merged to create more comprehensive schools.

Figure 5 provides an example of the type of map that could be generated from the above GIS procedures. In this case the district of Baksa in Assam state is the area of interest.
Figure 4. Enrolment and population distribution
Figure 5. Extent of co-location of government schools in Baksa district – a detailed view
3.4 Which UDISE indicators should be used to map aspects of inefficiency in the secondary school system?

GIS layers required:

- All schools (X and Y coordinates), or Government secondary schools
- State, district or census village boundaries as applicable, and secondary school age population
- Roads
- Background layers as required: OpenStreetMap and/or satellite imagery, topography

The following general steps would be used:

**Step 1:** In the GIS, open the layer of schools, boundaries, roads and background layers.

**Step 2:** Open the schools attribute table (assuming this has been joined to the UDISE data for schools).

**Step 3:** Create two new attributes: school utilization rate ‘Util_Rate’ and student/teacher ratio ‘STR’. These two new attributes can be very effective in highlighting aspects of inefficiency in the secondary school system for a particular area.

The school utilization rate is the class utilization rate and is given as the ratio of average class size to planned class size (assumed to be 40 students per class x the number of classrooms) times 100. The closer this value is to 100 percent the more utilized are the classrooms in a school. Low values indicate poor class utilization – excess classroom capacity at a school. Values above 100 generally indicate a level of overcrowding – insufficient classroom capacity at a school.

Student-teacher ratio is simply the ratio of total students to total teachers.

**Step 4:** Use the GIS to map the distribution of the school utilization rate by selecting graduated symbols for each school.

**Step 5:** In addition use the GIS to also map the distribution of the school age population as a choropleth map.

**Step 6:** Examine the joint distribution of both attributes.

**Step 7:** Save the map in a map folder on the working directory.

**Step 8:** Use the GIS to generate another map of the joint distribution of student/teacher ratio and secondary school aged population.

**Step 9:** Save the map in a map folder on the working directory.

**Value added by use of GIS:** The joint distribution of school utilization rate and secondary school aged population, or of the student/teacher ratio with secondary school aged population provides a school planner and decision maker with quantitative evidence for every school. This means schools in particular locations can be compared on these two measures of efficiency and inefficiency and the results correlated with the distribution of demand for students. Generally, low school utilization rates and low student/teacher ratios would be associated with sparse demand, and vice-versa. School utilization rates at 130 or above indicate overcrowding in schools, something that also needs to be examined by school planners and decision makers.

Figure 6 provides an example of the type of map that could be generated from the above GIS procedures (except for student/teacher ratio). In this case the district of Baksa in Assam state is the area of interest. Notice that there exist many secondary schools with excess capacity and a number of schools with overcrowding.
Figure 6. School utilization rates for government secondary schools
3.5 How to determine the catchment areas for schools of a certain size and distance norm?

GIS layers required:

- All schools (X and Y coordinates), or Government secondary schools
- State, district or census village boundaries as applicable, and secondary school age population
- Roads
- Background layers as required: OpenStreetMap and/or satellite imagery, topography

There are two procedures that could be used to estimate the size of secondary school catchment areas:

- Thiessen (Voronoi) polygons can be generated by the GIS such that the boundaries of the polygons define an area – a theoretical catchment area that is closest to each point (school)
- Estimate the population density required based on the maximum size of a school and distance norm. Use the formula provided by World Bank (1978).

The following general steps would be used:

**Step 1:** In the GIS, open the layer of schools, boundaries, roads and background layers.

**Step 2:** Use the Thiessen polygons (Voronoi polygons) geographic utility in the GIS to generate a layer of Thiessen polygons around each secondary school. Overlay this new layer on the map together with the distribution of the school age population for every census village boundary in the study area.

**Step 3:** To estimate the number of secondary school age persons in every Thiessen polygon – catchment area around a school use the Overlay and Intersect facility in the GIS. This will intersect each Thiessen polygon with the underlying census village boundaries and estimate the number of secondary school age persons within each Thiessen polygon – the school catchment area. A new Thiessen Polygon layer will be generated with the corresponding attributes of the population of the census village boundaries.

**Step 4:** Examine the attribute table of the new layer and map the resulting school age population for each Thiessen polygon.

**Step 5:** Map the distribution of enrolment size for all secondary schools in the study area. Save the map. Examine the correspondence between total secondary school age population of the theoretical catchment area and the enrolment size of a school.

**Step 6:** In the second method, the idea is to use the 5 km buffer around each secondary school to determine the threshold population and population density required given the maximum size of the school and a 100% enrolment rate.

For example, if a secondary school has a maximum size of 240 students (assuming 6 classrooms and a designed seating capacity of 40 students per class), and the secondary school age population (ages 14 and 15) represents 15% of the total national population, then the total population in the area must be 240 / .15 = 1600 people.

Within a 5 km radius around the school (an area of 78.55 km$^2$) the population density threshold must be 20.36 persons per square km (psk). There will need to be a total population of 1600 in this catchment area where the population density exceeds 20 psk. Therefore, in all areas where population density exceeds 20 psk, the threshold population required for a 240 space, six grade school is reached if the target enrollment rate is 100% and the secondary school can operate to capacity.
If in any area with this age-profile the population density is less than 20 psk, the threshold population will not be reached within the distance of 5 km from the school. Open the attribute table of layer census village boundaries. Map the attribute Total Population.

**Step 7:** Use the GIS to generate Buffers of 5 km size (radius) around each government secondary schools.

**Step 8:** Use the layer of population density for each village census boundary.

**Step 9:** Open the attribute table of the secondary schools layer and create a new attribute called ‘Max_Cap’ or maximum design capacity of the school (equal to the number of classrooms x 40 students per class).

**Step 10:** Use the calculator functions in the GIS to calculate the Max_Cap values for every secondary school.

**Step 11:** Use the select by attribute function in your GIS to select all secondary schools with a Max_Cap of 240 (this is an example only).

**Step 12:** Overlay the 5 km buffers around these selected schools.

**Step 13:** Use the select by attribute function your GIS to select all census village boundaries where the value of population density is 20.36 psk or above.

**Step 14:** Examine the results of both operations to determine which 5 km buffers have villages with population density less than 20.36 psk – where the threshold population is not reached within the 5 km distance criteria for secondary schools.

**Step 15:** Save the map to a working directory.

**Value added by use of GIS:** The value of Thiessen polygons is that they indicate a theoretical catchment area around each school. The procedures described above provide school planners and decision makers with quantitative evidence of the correspondence between total demand in this theoretical catchment area and the enrolment size of a school. It also suggests how much larger the theoretical catchment area should be for the school to reach maximum capacity – an area that may be larger than the accepted distance norm for travel to school.

In the second method the value of the GIS is that it identifies those census village boundaries where the threshold population density of 20.36 psk is not reached. For the school planners and decision makers this means that for the secondary schools concerned, in order for them to operate up to capacity one or more of the norms would need to be adjusted, (a) extend the distance to serve additional students (use the GIS to determine at which distance from the school the actual threshold population is reached) and, (b) reduce the threshold population required by having a smaller school(s).

Figure 7 provides an example of the Thiessen polygons that a GIS can generate for points – secondary schools in this case. In this case the district of Baksa in Assam state is the area of interest.

### 3.6 How to determine the spacing of secondary schools or of other school types using accepted distance norms (e.g. 5 km for secondary schools)?

**GIS layers required:**

- All schools (X and Y coordinates), or Government secondary schools
- State, district or census village boundaries as applicable, and secondary school age population
- Roads
- Background layers as required: OpenStreetMap and/or satellite imagery, topography
Figure 7. Thiessen polygons around government secondary schools
The following general steps would be used:

**Step 1:** In the GIS, open the layer of schools, boundaries, roads and background layers.

**Step 2:** Use the **Buffer** procedure in the GIS to generate 5 km radius buffers around each secondary school in your study area. Look for the extent of overlap (school spacing too close) and the underserved areas where there are no secondary schools to serve the population of that area (assuming there is a demand for secondary schooling in these underserved areas).

**Step 3:** Use the **Overlay and Intersect** operation within the GIS to determine the number of secondary schools within a 5 km radius.

**Step 4:** Repeat steps 2 and 3 for buffer size 1, 2, 3 and 4 km radius around each secondary school. Generate a table to show the results of this analysis.

**Step 5:** Save the map to a working directory.

**Value added by use of GIS:** The value of using multiple buffer rings of fixed size (1 km interval) around each secondary school in the study area is that one can then use the GIS to calculate the number of schools within each distance band. This provides quantitative evidence of the close spacing of secondary schools in both rural and urban areas, depending on the study area.

Figure 8 provides an example of the use of buffers around secondary schools to demonstrate the close spacing of schools and high level of overlap in the 5 km buffers. Even at 2 km buffers around schools there is a considerable degree of overlap. The majority of government secondary schools are, in fact, within a 2 km buffer radius of each respective school. This situation would suggest possible rationalization of closely spaced schools. In this case the district of Baksa in Assam state is the area of interest.

Figure 8. Geographic buffers around government secondary schools – Baksa district
3.7 How many secondary schools (along with their locations) would be needed if plans are developed using school planning norms and what will be their respective school size over next 5-10 years?

GIS layers required:

- All schools (X and Y coordinates), or Government secondary schools
- State, district or census village boundaries as applicable, and secondary school age population
- Roads
- Background layers as required: OpenStreetMap and/or satellite imagery, topography

The following general steps would be used:

The starting point for assessing the number of new schools and their optimum locations is the availability of an age specific census data file for the spatial units of interest; for example, total number of single year age cohort of the school age population (those aged 4-17) of villages in your study area. This type of census data can be requested from the Census of India. If not available, a survey may need to be undertaken of all school age children in villages in your study area of interest.

In the example used here, a full census of all villages in Baksa district (Assam state) was conducted by TCA and single year age cohort information was collected for the school aged population. This file contains information on current numbers of persons aged 14-15 (in 2015) and future numbers of persons who will be in the 14-15 year age group between 2016 and 2025. The key assumptions in the process of working out the future school age population are as follows:

- A 100% gross enrolment rate - where it is assumed that all students will be in a government secondary school
- The numbers of students in government secondary schools according to UDISE 2013-2014 are assumed as stable in 2014-2015 (similar numbers).

The steps described below detail the procedures developed and adopted to estimate the relevant secondary school age population. The discussion is based on the Excel file named ‘Projection of Baksa School Needs 2016-2025_v3’ which accompanies the research report.

As regards the use of GIS, the process is to take the aggregate estimated secondary school age population between the forecast years (2016-2025) and apportion it to each village.

**Step 1: Secondary school age students 2016-2025.** According to UDISE 2013-2014, a total of 24,123 students were enrolled across the 147 government secondary schools. This represents a gross enrolment rate of 66.4% using the total of 36,331 persons aged 14-15 in 2015 across Baksa villages. It is assumed this total of 24,123 students is enrolled in 2015.

Next, identify the number of persons who will be aged 14-15 for each year over the period 2016-2025. This information is taken directly from the census file. For example, in 2016, the number of persons aged 14-15 are those presently aged 14 (18,285) and those now aged 13 (17,836) – a total of 36,081. In 2017, the number of persons aged 14-15 are those presently aged 12 (17,858) and 13 years of age (17,836) – a total of 35,694 persons. Following this logic, those persons aged 14-15 in 2020 are those presently aged 9-10 years of age (total of 34,336 persons) and those persons aged 14-15 in 2025 are those presently aged 4-5 years of age (a total of 35,951 persons).

As can be seen, the number of persons aged 14-15 declines between 2016 and 2025.
**Step 2: Annual increment of persons aged 14-15.** The annual increment of persons aged 14-15 over the period 2016-2025 is calculated in order to see the number of new persons aged 14-15 added each year. (The base year of 2015 is critical for this estimation). As mentioned above, the base number of students used is 24,123 (this represents a gross enrolment rate of 66.9%). In 2016, the number of persons aged 14-15 will be 36,081. If a 100% enrolment rate is assumed then a total of 11,958 additional students will require places in schools in 2016.

Annual increments of persons aged 14-15 between 2017 and 2025 actually decline over this period. In fact, there is a net decrease of 494 persons aged 14-15 over this period despite some increases in the years 2022 and 2024. This implies that the number of schools to be provided for those new persons in the years 2016 will be more than adequate to meet demand that would be declining between 2017 and 2025.

**Step 3: Distribution of expected demand across villages.** In the GIS, open the census village boundaries layer that is joined with all population attributes.

**Step 4:** Create a new attribute field called ‘Pop_2016’ and use the calculator function of the GIS to apportion the total of 11,958 additional places across every census village. This is achieved by dividing the value of the existing population aged 14-15 in every village by the total of all persons aged 14-15 in 2015 for all villages and multiplying by 11,958. So the number of new places in a village is proportional to its present share of the total population aged 14-15 years of age.

**Step 5: Size of secondary schools and expected numbers of secondary schools.** Using the criteria of a minimum school size of 160 for a secondary school, and a demand of 11,958 persons aged 14-15 in 2016; there would be a requirement for 75 new schools in 2016. This number would be adequate in terms of capacity to meet the expected number of persons aged 14-15 between 2017 and 2025.

The number of government secondary schools that would be required if school size was set at 340 students and 520 students would be 35 and 23 new schools respectively.

Steps 4 and 5 are only of importance if school planners and decision makers are interested in new schools of different size. However, as has been mentioned in the ‘Introduction’ the problems are of inefficiency in the existing school system, so the priority would be to allocate additional demand into existing schools, especially those schools which have excess capacity. The GIS would be an ideal tool to achieve this priority as has been demonstrated above.

If school planners and decision makers perceive the need for new schools, then the GIS based methods in Part B of the GIS User Manual are suitable.

**Value added by use of GIS:** The ability to spatially apportion a total value (e.g. future students) to each spatial unit based on the spatial unit’s relative proportion of total current students. These estimated values of student demand for each spatial unit (e.g. village) can then be mapped and the distribution examined for high and low values. School utilization rates can then be mapped so that one has an excellent visual overview of expected demand and existing utilization of a school.

Figure 9 provides an example of the output of steps 4 and 5. In this case the district of Baksa in Assam state is the area of interest.

**3.8 What is the optimum location of new schools of various sizes and their optimum allocations of demand points (villages) to these schools using distance minimization and maximum population coverage criteria?**

See GIS User Manual Part B
Figure 9. Distribution of the secondary school age population by village in 2016 – Baksa district
3.9 What are the implications of relaxing distance norms and using school size criteria to determine school location?

See GIS User Manual Part B

3.10 How many schools are located close by the optimum locations of new schools and what is the locational significance of these nearby schools?

See GIS User Manual Part B

3.11 How to assess the accessibility characteristics of each optimum location solution to determine the best outcome for the education system?

See GIS User Manual Part B

3.12 How can low enrolment secondary schools be rationalized through mergers or closures?

There are two approaches that school planners can use, with the aid of GIS, to determine other locations of schools in an area. Both approaches involve rationalization of the government secondary school network:

- Rationalize the network of low enrolment schools
- Rationalize the network of all low enrolment government schools in an area; consolidation into comprehensive schools (grade 1-10).

In both of the above approaches, new schools may result from the process of rationalisation or existing schools may be upgraded with vertical and/or horizontal extensions to cater for the additional students that would be transferred from closed schools.

GIS layers required:

- All schools (X and Y coordinates), or Government secondary schools
- State, district or census village boundaries as applicable, and secondary school age population
- Roads
- Background layers as required: OpenStreetMap and/or satellite imagery, topography

The following general steps would be used:

**Step 1:** Open the GIS and add all the layers listed above.

**Step 2:** Use the attribute of secondary school age population and generate a choropleth map of the distribution of secondary school age population by village. This assumes the population data is joined, using Table Join, to the census village boundaries layer.

**Step 3:** For the secondary school layer, generate a map to show the different types of secondary schools (use various symbols for this process as in section 3.1). Label the schools with their names.

**Step 4:** Zoom into an area where there is relatively low numbers of secondary school aged population in villages and where there is a close spacing of secondary schools and associated feeder schools.

**Step 5:** Select a secondary school that is in the middle of the cluster of schools and use the GIS to generate 5 km radius buffer around the school.
Figure 10 provides an example applying Steps 1-5 for an area of Baksia district which contains a number of schools within a 5 km circular buffer. This area was selected as there are secondary schools located where there is relatively low demand (persons aged 14-15) for secondary education. There are many such areas that can be identified with GIS across Baksia district.

The buffer area shown in Figure 10 indicates that there are many primary schools and upper primary schools. Importantly, the area contains 10 secondary schools and two upper primary schools with secondary schools. The two upper-primary with secondary schools are located in the top part of the buffer area (just north of Adalhari).

**Step 6:** Use the ‘Information’ tool in the GIS to examine the enrolments in each of the 12 schools. These twelve schools can also be selected by the GIS and then examined in the schools’ attribute table. Use the statistics function to sum the enrolments in these schools.

GIS analysis of the UDISE data for these twelve schools indicates that they contain 1052 students and a total of 53 secondary classrooms. The estimated classroom capacity of these schools is 2120 classrooms (53 classrooms @ 40 students per classroom). Based on this information, it can be determined that the school utilization rate of these 12 schools is only 49.6% - largely due to low enrolments.

**Step 7:** Generate a table of all twelve secondary schools and selected key attributes of efficiency of the schools. Table 3 provides a summary of the twelve schools, together with some key attributes of enrolment and classrooms. All are co-educational schools except for Baleng Girls HS. Eight out of the 10 secondary schools have enrolments between 41 and 79 students – an indicator of the low enrolment status of schools in this particular area. The classroom capacity indicator highlights that these schools, with the exception of Magurmari Kalbari HS, have a very low level of school utilization; they have an excess capacity of student classroom space. In addition, most of these schools have an excess number of secondary teachers for the size of school. Some of these schools are candidates for rationalization.

**Table 3. Secondary schools within a 5 km circular buffer**

<table>
<thead>
<tr>
<th>Secondary School</th>
<th>Sec. Classrooms</th>
<th>Sec. Teachers</th>
<th>Sec. Students</th>
<th>Capacity</th>
<th>Student-Teacher Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bebejiapara HS</td>
<td>2</td>
<td>9</td>
<td>64</td>
<td>240</td>
<td>26.7</td>
</tr>
<tr>
<td>Betna Kaurbaha Milan HS</td>
<td>4</td>
<td>12</td>
<td>53</td>
<td>160</td>
<td>33.1</td>
</tr>
<tr>
<td>Namati Anchalik HS</td>
<td>5</td>
<td>14</td>
<td>66</td>
<td>200</td>
<td>33.0</td>
</tr>
<tr>
<td>Baleng Girls HS</td>
<td>2</td>
<td>7</td>
<td>55</td>
<td>80</td>
<td>68.8</td>
</tr>
<tr>
<td>Bhalukdonga Bidyamondir HS</td>
<td>4</td>
<td>18</td>
<td>73</td>
<td>160</td>
<td>45.6</td>
</tr>
<tr>
<td>Magurmari Kalbari HS</td>
<td>7</td>
<td>19</td>
<td>225</td>
<td>280</td>
<td>80.4</td>
</tr>
<tr>
<td>Karemura Ranaishree HS</td>
<td>2</td>
<td>9</td>
<td>79</td>
<td>240</td>
<td>32.9</td>
</tr>
<tr>
<td>Pamua Pather HS</td>
<td>3</td>
<td>8</td>
<td>66</td>
<td>240</td>
<td>27.5</td>
</tr>
<tr>
<td>Iragdao HS</td>
<td>2</td>
<td>10</td>
<td>72</td>
<td>240</td>
<td>30.0</td>
</tr>
<tr>
<td>Kharua Milan HS</td>
<td>3</td>
<td>12</td>
<td>41</td>
<td>120</td>
<td>34.2</td>
</tr>
<tr>
<td>Kalaguru Bisnu Rabha HS (Upper Primary with Secondary)</td>
<td>2</td>
<td>5</td>
<td>250</td>
<td>80</td>
<td>50.0</td>
</tr>
<tr>
<td>Jawahar Navoday Vidyalaya HS (Upper Primary with Secondary)</td>
<td>2</td>
<td>5</td>
<td>8</td>
<td>80</td>
<td>16.0</td>
</tr>
</tbody>
</table>
Figure 10. Distribution of government schools with a 5 km circular buffer
Step 8: From the above steps it is possible to develop proposals for likely rationalization of schools (closed in this case) and students transferred to another nearby school. In this exercise, use the roads layer to assist in ensuring that norms of distance from home to school are maintained in the rationalization proposals. These distance norms could also be varied by the school planners.

Step 9: From Table 3 and Figure 10, the following proposals could be suggested for merger:

- Closure of Jawahar Navaday Vidyalya HS and transfer of 8 students to Kalaguru Bisnu Rabha HS; No effect on student travel to school; Surplus teachers = 2-3
- Closure of Kharua Milan HS and transfer of 41 students to Iragdao HS; Additional 1.2 km of travel to Iragdao HS; Surplus teachers =12
- Closure of Baleng Girls HS and transfer of 55 students to Bhalukdonga Bidyamondir HS; Very minor increase (500 metres) in student travel to school; Surplus teachers = 7
- Closure of Betna Kaurbaha Milan HS and transfer of 53 students to Bebejiapara HS; No effect on student travel to school; Surplus teachers = 12.

The above proposals are only used as an example of how the GIS could be utilized for rationalization purposes. It is not intended that the above schools actually be rationalized.

Step 10: The second approach to school siting could be to merge primary, upper primary and secondary schools in the area to form a comprehensive school from grades 1-10. This could either be a new school which is located in close proximity of these other schools (using school planning norms) or an existing school with sufficient excess capacity to accept the transfer of students to its classrooms.

Step 11: As with the previous approach, use the GIS (especially the ‘Identity’ tool) to identify candidate schools for merger/closure and transfer of students to a ‘new’ comprehensive school.

From Figure 10, the following schools could be merged into one comprehensive school (grade 1-10):

- Closure of Betna Kaurbaha Milan HS and transfer of 53 students to Bebejiapara HS; Closure of Bebejiapara Upper Primary School and transfer of 70 students to Bebejiapara HS; Closure of Bebejiapara Local Primary School and transfer of 45 students to Bebejiapara HS. Very minimal effect on primary student travel to school (410 m increased travel); Bebejiapara HS has capacity to become a comprehensive school with total enrolments of 232 students and a capacity of 240 students.
- Closure of Karemura Upper Primary School and transfer of 69 students to Karemura Ranaishree HS; 805 Karemura Local Primary School and transfer of 43 students to Karemura Ranaishree HS; Very minimal effect on primary student travel to school (650 meters increased travel); Karemura Ranaishree HS has capacity to become a comprehensive school with total enrolments of 191 students and a capacity of 240 students.
- Closure of Cheunipam Local Primary School and transfer of 33 students to Bhalukdonga Bidyamondir HS; Closure of Bhalukdonga Bidyamondir Upper Primary School and transfer of 86 students to Bhalukdonga Bidyamondir HS; minimal effect on primary student travel to school (770 meters increased travel); Bhalukdonga Bidyamondir HS has capacity to become a comprehensive school with total enrolments of 192 students. However, this would require the addition of an extra classroom of 40 students given the capacity of the present school of 160 students.
- Closure of Kharua Milan HS and transfer of 41 students to Iragdao HS; Closure of Iragdao Upper Primary School and transfer of 93 students to Iragdao HS; Additional 1.2 km of travel to Iragdao HS; Iragdao HS has capacity to become a comprehensive school with total enrolments of 206 students and a capacity of 240 students.

Value added by use of GIS: The above examples, which are not comprehensive by any means, demonstrate that by using GIS it is possible to contemplate scenarios for creation of comprehensive schools in this particular area. Needless to say, this exercise could be repeated for other areas across
Baksa district by using GIS to co-locate government schools of interest and to filter these schools by low enrolments and other efficiency indicators.

3.13 How can GIS information be used to optimize school resourcing for ensuring maximum efficiency?

GIS layers required:

- All schools (X and Y coordinates), or Government secondary schools and UDISE attributes of schools
- State, district or census village boundaries as applicable, and secondary school age population
- Roads
- Background layers as required: OpenStreetMap and/or satellite imagery, topography

The information presented in previous sections highlights that GIS can not only be used for analytical modelling of various scenarios, but can also be used to monitor school and education resourcing. For example, several of the Figures presented so far in the report visualized the distribution of school indicators or other attributes of demand from the census file. Maps of school utilization rates, enrolment size and demand, 5km buffers around government secondary schools and the spatial distribution of various types of government secondary schools provide school planners and policy makers with a view of current resourcing. More importantly, these types of maps highlight problems in the distribution of resources and the likely need for policy interventions to redress resource allocation issues. Most of these visualizations have been based on the UDISE 2013-2014 data.

Fortunately, the same school data contains a myriad of other school attributes that can be visualized for the same purposes. For example, attributes of teacher qualifications, presence/absence of boys and girls toilets in schools, presence/absence of a library and electricity, playground and water facility in schools provides the raw data that can be used by GIS with a layer of secondary school locations to map the distribution of these resources.

The maps that appear in the following pages take the attributes in the UDISE data and visualized the distribution of the phenomena.

The following general steps would be used:

**Step 1:** Open the GIS and add all the layers listed above.

**Step 2:** Use the attribute of secondary school age population and generate a choropleth map of the distribution of secondary school age population by village. This assumes the population data is joined, using Table Join, to the census village boundaries layer.

**Step 3:** Open the attribute table of the Secondary Schools layer.

**Step 4:** Generate a map of the distribution of schools that have or do not have both boys and girls toilets present in respective secondary schools. Save the map.

**Step 5:** Generate a map of government secondary schools that do or do not have electricity on their site. Save the map.
Step 6: Generate a map of the distribution of the total number of facilities in government secondary schools, where facilities is made up of the presence/absence of both boys and girls toilets, electricity, water facility, library and playground. Save the map.

Step 7: Generate a map of the distribution of the number of teachers with academic qualifications at graduate level or above. Save the map.

Value added by use of GIS: In sum, the sets of maps that could be produced with the use of GIS allow school planners to both assess issues of school resourcing and to identify remedial strategies for improving the efficiency of the education system. The maps produced so far indicate that there is much work to be undertaken in Baksa district to improve school resources and efficiency of the secondary education system. Visualization of school resource attributes is the first step toward understanding the magnitude and scale of any problems, and a generator of solution strategies for improved efficiency.

Only two of the four suggested maps have been included in the following pages as examples of how to visualized school resourcing issues. Figure 1 shows the distribution of schools that have or do not have both boys and girls toilets present in respective secondary schools. Figure 12 indicates those schools’ that do or do not have electricity on their site.
Figure 11. Distribution of secondary schools with both boys’ and girls’ toilets
Figure 12. Distribution of secondary schools with and without electricity
GIS based analysis for planning new school locations

PART B: Case study – GIS for planning new school locations
4. Part B Introduction

Part B of the User Manual has been prepared to provide school planners and decision makers the procedures necessary for planning new school locations using GIS based methods.

All GIS based analysis presented in this part of the User Manual uses software called ArcGIS Desktop 10.3.1. This software is used with the advanced license which means that all extensions are available for use within ArcGIS. However, ArcGIS Desktop 10.3.1 can operate without any extensions but its analytical capability is severely limited without the capacity of these. It should also be noted that most of the analyses and procedures presented in Part B of the User Manual could be performed using earlier versions of ArcGIS and Network Analyst. Appendix 1 provides details of how to download a free 60 day trial of ArcGIS 10.3.1 that contains all extensions.

One extension in particular – Network Analyst 10.3.1 – is the basis of all work describing procedures for new school location. These are referred to as location-allocation procedures. Other GIS procedures, not part of the Network Analyst extension – are used for follow-up analysis of location-allocation outputs. These latter procedures are part of more general GIS analysis procedures found in ArcGIS and, in particular, with ArcMap – a key component of ArcGIS.

All GIS layers required for determining new school locations are standardized layers required by Network Analyst in order to run procedures such as location-allocation and service areas. These layers include:

- A network dataset (based on a road layer)
- Demand points (villages)
- A set of candidate facilities

It is the pre-processing of these layers that is paramount in generating what is referred to as a network dataset that is, in turn, used by the location-allocation procedures to solve for optimum locations and allocations.

In addition, the procedures and analyses presented in the User Manual are based on GIS work undertaken by the consultant for Baksa district in Assam state - the basis of the Research Paper presented to TCA. All of the GIS procedures and analyses discussed in the manual use ArcGIS 10.3.1, in particular, the ArcMap component that is installed on a HP laptop running Windows 7 Ultimate.

Finally, the content of this document assumes a minimum level of familiarity with GIS layers, procedures and work flows, and basic familiarity with ArcGIS and its main component - ArcMap.

4.1 Why use ArcGIS?

Of all the GIS software presented in Table 2, the most technically comprehensive for applications of optimum-location-allocation procedures is ArcGIS. By technically comprehensive is meant the following:

- A full range of location-allocation problem types that relate to finding well-chosen school locations that provide a high quality teaching and learning environment to communities at low cost:
  - Minimize impedance
  - Maximize coverage
  - Maximize capacitated coverage
  - Minimize facilities
  - Maximize attendance
  - Maximize market share
  - Target market share
• A requirement for a topologically correct geometric network, such as a road network, where all nodes (end points or intersections) and links (sections) are connected. Relevant attributes are available for all links such as distance and/or travel time. One of the key advantages of ArcGIS is the ability to import or generate a line GIS layer that can be transformed to a topologically correct network for location-allocation analysis purposes. Editing of the network is facilitated by special tools.

• Ability to specify the exact nature of the location-allocation problem – optimum location-allocation, service areas, closest facility or shortest route, etc. One has the ability to specify that Network Analyst will find optimum locations that are at intersections on the road network or at locations off the road network. Different algorithms are used for these specifications.

• Performing the analysis and displaying the results. The outputs of the optimum location-allocation procedure are output to the map and the user has the ability to alter the visual aspects of the output to make them more cartographically appealing to the end users.

In addition to the above advantages of using ArcGIS Network Analyst, all other layers that are part of the analysis are visualized and integrated with the location-allocation outputs. It is the ability of ArcGIS to undertake these complex geoprocessing tasks and integrate them with other GIS layers as part of the GIS database that is a major advantage of the software.

The visualization aspects of ArcGIS are probably the best in the industry and ArcGIS also has the ability, through ArcGIS Online, to publish maps to the web. The range of symbols, color schemes, labelling options and layout formatting options are superior to the other Desktop programs mentioned in Table 2.

An important justification for use of any GIS is not just the accuracy of the mathematical algorithms that it sues for various analyses, but the ease of use of the software – especially for those just starting out with GIS. While ArcGIS has a very steep learning curve, the level of official resources available both offline and online for learning are of the highest quality and abundant. There is also a global community of ArcGIS users who contribute to ‘Help’ issues for new users.

At the end of the day, it is up to the school planners and decision makers as to the right GIS to select and use. Price will obviously be an important consideration in this decision. All of the software shown in Table 2 is undergoing rapid developments and it is very likely that the technical superiority of ArcGIS for optimum location-allocation analysis will be matched by developments with QGIS and Supergeo GIS in the not too distant future.

5. Base GIS layers

All GIS layers used in Part B of this manual are assumed to be located in the following directory on the users’ computer:
C:\Baksa\n
The location of all GIS layers described in the manual can be located on any directory, and on any drive on a local computer or computer network. In this case, the use of ArcGIS and ArcMap will need to be pointed in the direction of the drive and folder containing the GIS layers.

The GIS layers listed below are considered the base layers that the user should be working with for analysis purposes and for the generation of maps and layouts. Each base layer is in a standard SHAPE file format (.SHP) as provided by TCA. It is important to note that each GIS layer in SHP format is made up of at least 4-5 other files, each having the same prefix but different suffixes. For example, other suffixes may be .PRJ, .SHX, .SBX, .DBF and so on. The Village_Boundaries shape file (a GIS layer) is made up of the following files:
It is important that all these files be kept together so that if the GIS layer is copied or sent to someone, the entire sequence of files that make up the shape file as a GIS layer are copied or sent.

**Base layers (Shape files):**

- **Govt_Sec_Schools**
  
  This GIS layer is composed of the geographic locations of all 147 government secondary schools in Baksa district together with the corresponding UDISE 2013-2014 attributes of the schools. It is the result of joining the attribute table of the school locations with the attribute table of the UDISE file using the SCHCD (School ID) attribute as the common attribute for the join.

- **Villages_Boundaries**
  
  A GIS layer of village boundaries obtained from TCA that contains boundaries of 713 villages in Baksa district. This GIS layer has been modified from the original GIS layer as the original layer contained multiple errors such as duplicate boundaries and incomplete boundaries.
  
  The Villages_Boundaries GIS layer is the result of joining the location attributes of the villages with their corresponding census attribute data from the Anganwadi census file provided by TCA. The join was completed using the Village Code attribute common to both files.

- **Rivers_Clip**
  
  A GIS layer of all rivers in Baksa district that was generated from a more detailed and extensive coverage of rivers for Assam provided by TCA. The Villages_Boundaries GIS layer was used to clip the rivers that are within the extent of the rivers in the village boundaries layer.

- **Detailed_Roads**
  
  A GIS layer generated for the research exercise that is based on a capture of most roads in the district. It is a more detailed and disaggregated layer of roads as compared to the main road only layer obtained by TCA. The methods used to generate this detailed roads layer have been described elsewhere.
  
  The original main roads GIS layer covered all of Assam state. This layer was clipped to reflect only those roads within Baksa and that surround Baksa district. This clipped layer was then used to develop the more detailed layer by digitizing other roads from a satellite image.
  
  The following image is a screenshot from ArcGIS that shows the detailed roads layer (in blue) relative to the original main road layer (in red).
From the above descriptions of base GIS layers it can be seen that there is a certain amount of pre-processing of data that is required to generate each respective layer. The type of pre-processing utilizes standard GIS procedures that would be used by a GIS Analyst to generate the required layers.

There is additional processing of these GIS layers once they are opened in ArcGIS.

- **OpenStreetMap**

One additional base layer that is also seen in the above image is the OpenStreetMap layer that covers Baksa district and surrounds. This layer is a background layer to provide context for other GIS layers. It is available to be added directly from ArcGIS. OpenStreetMap is a free layer that covers most of the world.

6. **Inputting GIS layers into ArcMap and saving a map**

Start ArcGIS → ArcMap from the Start Menu as per the diagram below, or from Start Menu → Programs → ArcGIS → ArcMap.
After ArcMap opens you should see a screen as below:

Use the following steps to add the various GIS layers (SHAPE files) of interest to ArcMap for analysis purposes:

**Step 1:** Use the add data button to add the GIS layers:

GIS layers could also be added through another component of ArcGIS called ArcCatalog.
Step 2: Open folder connections

The directory C:\Baksa is already connected in this case, but if it were not connected you would use the Folder Connections icon to point to the directory and connect to it.
Step 3: Examine the layers of interest inside C:\Baksa and select layers to add to ArcMap window. Multiple GIS layers can be selected simultaneously by clicking on one then holding the CTRL key and selecting another and another, and so on.

In the above example the GIS layers named Detailed_Roads, Govt_Sec_Schools, Rivers_Clip and Village_Boundaries layers have been selected to be added to ArcMap. Your Layers in ArcMap should look like those shown in the figure below:
Step 4: Modify the look and size of the layers

- Use the zoom in and zoom out buttons on the top left of the tools bar to resize your map so it occupies the ArcMap screen. The pan button can also be used to position the map in the center of the screen.
- The symbols for Govt_Sec_Schools and other layers can be changed by double-clicking next to the current symbol and selecting the required symbol, symbol size and color. For example:
  
  ![Double click this symbol and change symbol style, color and weight.](image)

It is important to note that the 4 layers in ArcMap are all on the same projection and coordinate system. However, this is not how all these layers were presented to TCA. The Govt_Sec_Schools layer was generated from a file of School Points that used Latitude and Longitude coordinates. The Rivers_Clip layers, Detailed_Roads and Villages_Boundaries use the same projected coordinate system known as Lambert Conformal Conic where the coordinates are in meters. The units of the coordinate system are shown in the bottom right hand side of the ArcMap screen.

Step 5: To see what projection and coordinate system is being used for each layer simply highlight the layer and right click to see a list of features. Scroll down and select Properties.

![Layer Properties](image)

Then from Layer Properties select Source to see details about the layer including the projected coordinate system – in this case Lambert Conformal Conic in meters. It is possible to have all layers in latitude/longitude coordinate system for display purposes but this is not adequate for analysis purposes.
The advantage of a true projected coordinate system in meters is that it is possible to make correct calculations of length and area and volume. For example, this projected coordinate system can be used to calculate the area of each village boundary which, in turn, enables calculation of density characteristics; calculation of length (in meters) of each road segment that makes up the road layer – these are very desirable attributes as will be seen later in the manual.
The layer properties window has other tabs that can be viewed such as Symbology and Fields, etc. Symbology for the layer can also be changed in the Layer Properties window and the Fields tab is used to see what attributes of the layer are present and the details of each field such as format.

**Step 6: Add the OpenStreetMap layer as a base map to ArcMap**

- To add the OpenStreetMap layer as a background layer to ArcMap go back to the add data button and using the mouse arrow click to the right of the add data button on the down arrow symbol

![Click on down arrow symbol then select Add Basemap](image)

- Select OpenStreetMap as the preferred layer. One could also select the ESRI World Street layer (Streets) instead. Note that in this window one could also select Satellite Imagery or Satellite Imagery with labels as a background.
- The selected OpenStreetMap layer is added as background to the map window.
• Change the transparency of the village boundary layer so that one can see through the symbol for the layer and see the OpenStreetMap layer underneath. Do this by highlighting the Villages_Boundaries layer with your mouse, right clicking on the layer name, selecting
Properties and then Display under Layer Properties: change the value of Transparent from 0% to 45% or higher (see below). Click OK.

Please note that OpenStreetMap is added as a layer in the Table of Contents on the left part of the ArcMap screen. As the last layer added it is at the bottom of the Layers list. The order of layers is important in ArcMap and these can be moved up and down by selecting them and dragging them up or down. To enable this procedure, first highlight Layers with your mouse, right click and go down and click Activate.

**Step 7: Save the map.**

The contents shown in Table of Contents and the corresponding map can be saved as a map file that can be opened at a later time. All ArcMap map files have a .mxd extension. These are text files that contain a set of instructions that allow ArcMap to reconstruct the layers and any analysis that was undertaken. This file should ideally be located in the same directory as the GIS layer files (C:\Baksa).

Click File > Save As.

For Save As Type (at the bottom), click ArcMap map (*.mxd).

For File Name, type “Map_1” and click Save.

This enables one to close ArcMap without losing their work. ArcMap can be reopened and the Map_1.mxd file (map) selected and opened on the screen. All layers and any analysis will be shown.
7. Generating a layer of village centroids

The Villages_Boundaries layer is a layer that contains a closed boundary for every village. The technical name for a closed boundary is a polygon. Each polygon identifies a village by a code, village name, district and state, and contains the joined attributes from the Anganwadi census file.

One key attribute added to this file is the estimated number of persons aged 14-15 in 2016. This attribute was generated from the Excel file named ‘Projection of Baksa School Needs 2016-2025_v3’ which accompanied the Research Report. This attribute represents the demand in every village for government secondary schools.

Given the current polygon feature of every village, this attribute cannot be used for location-allocation analysis using Network Analyst in ArcMap. The reason for this is that the polygon structure cannot be connected to the road network. However, by converting the polygon features to points one would be able to attach these to the road network.

The conversion of polygon features to points is a process of generating centroids, or points to represent all attributes for each respective village. A centroid is normally found at the geographic center of the village boundary. The following steps are necessary:

**Step 1:** Click the ArcToolbox button located on the top row of toolbars in ArcMap

**Step 2:** From the range of tools shown, go down and select Data Management Tools.

**Step 3:** Click the + symbol to see all options

**Step 4:** From the list of options, select Features
Step 5: Select Feature to Point

Step 6: The Feature to Point window appears. The Input Features is the Villages_Boundaries layer. The Output Feature Class is the name you assign to the new layer of points (centroids). You need to check the Inside box so that centroids will always be located inside a boundary.

One can either click and drag the Villages_Boundaries layer from the Table of Contents to the Input Features line or one can click the yellow button to the right and search for the layer to input.
The Output Feature Class in this case is named Villages_Points and is located in the C:\Baksa\ folder.

Click OK.

**Step 7:** The Features to Point tool works in the background to generate the new layer. The new layer is automatically added to the Table of Contents (at the top of the layer list).

**Step 8:** To open the attribute table for Villages_Points and see all attributes, especially the demand attribute, do the following:

- Highlight the Villages_Points layer with your mouse
- Right click on the layer name and select Open Attribute Table
• The attribute table opens to display a list of attributes and their date for every village (n=713).
• Only a section of the attribute table is able to be viewed. By scrolling to the right one can see all attributes.

• A key attribute of interest for later use is the attributed titled SCH2016 that appears toward the end of the attribute table (highlighted in blue).
Step 9: Moving 3 village centroids

Several village centroids associated with large village boundaries and areas in the western part of Baksa need to have their centroids moved closer to their respective population concentrations and road network. These three villages are:

- Manas RF
- Kahitama RF
- Guma RF

**Google Earth Pro** was used to locate the 3 village areas and determine where the closest population concentration and road network is located. Being such large forest areas, there are very few clusters of population and even fewer roads. However, these villages have a small number of persons aged 14-15 in their population. If the centroids of these villages were not moved, the location-allocation procedure would not consider these locations as demand points.

- Click Customize > Toolbars (top of the ArcMap window)

The Toolbars dialog box opens.

- Check Editor.
- The Editor toolbar appears in the Toolbars window of ArcMap.
- Click Editor > Start Editing and select the layer to be edited, in this case Villages_Points
- Click OK and Continue
- The Editor toolbar is activated

Select the pointer tool and go to the map to locate the 3 centroids
- Click once on the first centroid (it is highlighted in blue) and move to the desired location
• Repeat this process for the second and third centroids. When you select the second centroid, the first centroid changes color to the original symbol color and the second centroid is highlighted in blue.

• Go back to the Editor
• Click Save Edits
• Click Stop Editing (this brings you out of the Editing environment and back to ArcMap)
Step 9: Save the map so that all new layers are saved. Go to File \[Save.\]

8. Generating a network dataset

A network dataset is a special dataset required by the Network Analyst extension of ArcGIS for performing analyses on network data in ArcMap. In this current example, it is made up of inputs from a road layer which is topologically correct (it could be a rail layer or public transport layer etc.). These inputs are stored in a special format with connectivity relations defined between links (edges) and nodes that make up the network. For links there can be attributes that define the cost of traversing each link such as distance or travel time.

**Step 1:** Start ArcCatalog by clicking Start > All Programs > ArcGIS > ArcCatalog. Alternatively, go to the tool menu of ArcMap and double-click the ArcCatalog icon (located next to ArcToolBox icon).

**Step 2:** Enable the Network Analyst extension.
- Click Customize > Extensions.
  
The Extensions dialog box opens.
  - Check Network Analyst.
  - Click Close.

**Step 3:** On the Standard toolbar, click the Connect To Folder button.

The Connect to Folder dialog box opens.
- Navigate to the folder with the Detailed_Roads layer (C:\Baksa\).
- Click OK.

**Step 4:** Highlight the Detailed_Roads layer and right click. Scroll down and click on New Network Dataset
The New Network Dataset wizard opens.

**Step 5:** Type Baksa_Roads_ND for the name of the network dataset. (Any name can be assigned here).

- Click **Next**.

**Step 6:** Click **No** to not model turns in the network. (If this was a proper urban transport network with intersections this would be clicked to **Yes**).
Step 7: Click Connectivity.

The Connectivity dialog box opens. Here you can set up the connectivity model for the network.

- For this Detailed Roads feature class, all roads connect to each other at endpoints.
- Make sure that the connectivity policy of Detailed Roads is set to End Point.
- Click OK to return to the New Network Dataset wizard.
- Click Next.

Step 8: This dataset has no elevation fields so select None and click Next.

Step 9: The page for setting network attributes is displayed.
The **Length** attribute is automatically selected with units **Meters**. ArcGIS Network Analyst analyzes the source feature class (or classes) and looks for common fields like Length, Meters, Minutes (FT_Minutes and TF_Minutes, one for each direction), and Oneway. If it finds these fields, it automatically creates the corresponding network attributes and assigns the respective fields to them.

- Click **Next**

**Step 10:** Leave the Travel Mode screen blank for this exercise
• Click Next

**Step 11:** Check No Driving Directions

• Click Next

**Step 12:** A summary of all the settings is displayed for your review.

• Click Finish.
Step 13: The new network dataset is created. Would you like to build it now?

- Click Yes

Step 14: Once the building of the network dataset has finished, the system asks if you would like the network components added as layers to the Table of Contents (see figure on next page):

- Click Yes
- The various components such as junctions (nodes) and edges (links) are added as layers to the Table of Contents with the ND designator to indicate they are network dataset components:
  - Detailed_Roads_ND_Junctions
  - Detailed_Roads_ND (edges)
  - Detailed_Roads (a new road layer)

Please note that a new road layer is also created and added to the Table of Contents. These can be toggled on and off by checking or unchecking the arrow next to the layer name.

- Check that the Detailed_Roads_ND dataset is displayed in the Network Analyst window

Step 15: To view the built network with edges and junctions, turn off all other layers except:

- Detailed_Roads_ND_Junctions
- Detailed_Roads_ND (edges)

Change the symbol color for edges to a darker color.

See figure on page 25
Network Dataset Component

Network Dataset Component

Network Dataset Component

Layers

- Nodes_Detailed_Roads
- Detailed_Roads_ND_Junctions
- Villages_Points
- Govt_Sec_Schools
- Detailed_Roads
- Detailed_Roads_ND
  - Edges
- Detailed_Roads
- Rivers_Clip
- Basemap
  - OpenStreetMap
9. Using network analyst for location-allocation analysis

The examples of network analysis functions provided with the Network Analyst extension are:

- Finding the best route
- Finding the closest facility
- Finding service areas
- Creating an OD cost matrix
- Solving a vehicle routing problem
- Finding optimum locations-allocations

The location-allocation function is used in this Manual and is based on analyses undertaken for the Research paper. The example chosen is that of finding the optimum locations of 23 government secondary where distance from a school to the closest villages is minimized within a distance constraint of 10 km. Optimum allocations of village centroids to the 23 optimum locations are also generated by the procedure. These procedures provide answers to questions 8 and 9 on page 5 of the Manual.

It should be noted that the procedures described in the following pages are exactly the same procedures that would be used for alternative criteria and distance constraints – such as maximizing coverage with capacity constraints or maximizing attendance using 5 km, 10 km or 15 km distance constraints.

The reader is referred to the following online source for full documentation of Network Analyst and its various procedures:


(Accessed 13 December 2015)

All of the tutorial data associated with the above online resource are normally installed when ArcGIS is installed. The default location for the tutorial data is given as:

C:\ArcGIS\ArcTutor\Network Analyst\Tutorial.

Other useful sources of help are to be found in the Network Analyst procedures themselves.

9.1 Preparing your display

Step 1: If you have Map_1.mxd open in ArcMap, skip to step 4.

Step 2: Start ArcMap by clicking Start > All Programs > ArcGIS > ArcMap 10.3.1

Step 3: On the ArcMap - Getting Started dialog box, click Existing Maps > Browse for more.

Step 4: Double-click Map_1.mxd.

The map document opens in ArcMap.

Step 5: Enable the Network Analyst extension (if not already open)

a. Click Customize > Extensions.

The Extensions dialog box opens.

b. Check Network Analyst.
c. Click Close.

If the Network Analyst toolbar is not displayed, you need to add it.

**Step 7:** Click Customize > Toolbars > Network Analyst.

The Network Analyst toolbar is added to ArcMap.

If the Network Analyst window is not displayed, you need to add it.

**Step 8:** On the Network Analyst toolbar, click the Show/Hide Network Analyst Window button.

The dockable Network Analyst window opens.

You can dock or undock the Network Analyst window. In this manual, it is docked in the Table Of Contents window.

### 9.2 Creating the location-allocation analysis layer

Step 1: Click Network Analyst on the Network Analyst toolbar and click New Location-Allocation.
The location-allocation analysis layer is added to the Network Analyst window. The network analysis classes (Facilities, Demand Points, Lines, Point Barriers, Line Barriers, and Polygon Barriers) are empty.
The analysis layer is also added to the Table Of Contents window.

### 9.3 Adding candidate facilities

You will add the candidate locations to the network analysis class **Facilities**. These are the potential places where one could locate a government secondary school. The solution from the location-allocation process will include a subset of these locations.

The candidate locations in this example are the node locations that are already added as a layer (Detailed_Roads_ND_Junctions) in the map document. The IDs of the nodes are contained in the layer's attribute table and there are 4147 nodes. You will load the nodes (points) features from Detailed_Roads_ND_Junctions into the Facilities class of the location-allocation layer.

**Step 1:** In the Network Analyst window click the Layer Properties icon.

**Step 2:** In Layer Properties click the Network Locations tab.

**Step 3:** Check the Snap to Closest button and under Name tick the Detailed_Roads and Shape field.

- Click OK.
This ensures that locations such as Facilities and Demand Points are attached to the closest Detailed_Roads road link (edge).

Step 4: In the Network Analyst window, right-click Facilities (0) and choose Load Locations.

- Select Detailed_Roads_ND_Junctions from the Load Locations drop-down list.
- Ensure that Facility Type is set to the Default Value Candidate. In this example, all of the node junctions are candidates to be selected as optimum facilities. The existing government secondary schools are not considered in any way in this analysis.
- Click **Advanced** at the lower left of the window
- Check Snap to Position Along Network
- Check Offset and set the value to 1000 meters
- Check the box Loading locations from location fields
- Click Ok.

This also ensures that the Facilities to be loaded are to be placed in their correct location on the network.

- Go back to the Load Locations window and click OK.

A total of 4147 candidate nodes are loaded into the Facilities network analysis class. The new facilities are listed in the Network Analyst window and displayed on the map.
9.4 Adding demand points

The optimal locations (schools) need to be located to best service the existing population of persons aged 14-15 in 2016. A point layer of village centroids is already added to ArcMap. Now you will load these centroids into the demand points network analysis class.

Step 1: In the Network Analyst window, right-click Demand Points (0) and choose Load Locations.

Step 2: Select Village_Points from the Load Locations drop-down list.

Step 3: Click the Field column for the Weight property and choose SCH_2016.

Each centroid point will be weighted by the person aged 14-15 in 2016 from the Anganwadi census file that has been joined to the table of villages as points.

- Click Advanced at the lower left of the window
- Check Snap to Position Along Network
- Check Offset and set the value to 1000 metres
- Check the box Loading locations from location fields
- Click Ok.

This also ensures that the Demand Points to be loaded are to be placed in their correct location on the network.

Step 4: Go back to the Load Locations window and click OK.
The 713 village centroids are loaded into the Demand Points class. The new demand points are listed in the Network Analyst window and displayed on the map.
9.5 Adding physical barrier (polygon) constraints

The layer of Rivers for Baksa acts as a physical barrier constraint to the movement of school students from villages to optimal secondary school locations. The Rivers layer is a polygon layer that when treated as physical barriers acts to prevent village centroids being allocated to an optimal location where it would be necessary to cross a river. From experience in use of physical barrier constraints with location-allocation analysis, the outcomes are generally correct; villages are generally assigned to other close facilities as an alternative. In some case, if the villages are beyond the maximum distance constraint for the problem, they are simply not allocated to any optimal location.

**Step 1:** In the Network Analyst window, right-click Polygon Barriers (0) and choose Load Locations.

**Step 2:** Select Rivers_Clip from the Load Locations drop-down list.

**Step 3:** Click Ok.

The 127 river polygons are loaded into the Polygon Barriers class. The new polygons that will act as barriers are listed in the Network Analyst window and displayed on the map.

9.6 Setting up the properties of the location-allocation analysis

**Step 1:** Click the Analysis Layer Properties button on the Network Analyst window.

The Layer Properties dialog box opens.

**Step 2:** Click the Analysis Settings tab.

**Step 3:** Make sure that Impedance is set to Length (Meters).

**Step 4:** Leave Use Start Time unchecked.
**Step 5:** Set Travel From to Demand to Facility.

In this case, demand (from villages) tends to travel to the facilities (government secondary schools), thus Demand to Facility is often a good choice for them.

The default option, Facility to Demand, is a good choice for other types of location problems.

**Step 6:** Click the U-Turns at Junctions drop-down arrow and choose Allowed.

**Step 7:** Set Output Shape Type to Straight Line.

Although the output will be displayed with straight lines, the travel costs are still measured along the network.

**Step 8:** Make sure that the Ignore Invalid Locations box is checked.

**Step 9:** Click Apply.

**Step 10:** Click Ok.

Your Analysis Settings tab should look like the following graphic:
Step 11: Click the Advanced Settings tab.

Step 12: Click the Problem Type drop-down list and choose Minimize Impedance.

These problem types are often referred to as models. Minimize impedance is a good problem type for choosing school locations, since it assumes that demand in villages will travel to the closest school.

Step 13: Increase Facilities To Choose to 23. ArcGIS will try to choose 23 facilities out of the 4147 to optimally serve the 713 demand points.

Step 14: Increase Impedance Cutoff to 10,000 meters (10 km).

This setting implies that people are not willing to travel more than 10 km from villages to these schools. The units for this value are determined by the units of the impedance attribute.

Step 15: Make sure that Impedance Transformation is set to Linear. ArcGIS will use a linear decay in calculating people's propensity to travel to a school. That is, with a 10 km impedance cutoff and a linear impedance transformation, the probability of travelling to a school decays at 1/10, or 10 percent; therefore, a school 1 km away from a demand point (village) has an 90 percent probability of a visit compared to a school 4 km away, which only has a 60 percent probability.

Step 16: Click OK.
9.7 Run the process to determine the 23 optimum school locations

**Step 1:** Click the Solve button on the Network Analyst toolbar.

Once the solve process is completed, lines in the map display connect chosen optimum locations to their associated demand points. The lines also appear in the Lines class in the Network Analyst window.

Several warning messages may appear before the process is complete to indicate if a demand point is not able to be traversed or located. Click OK.

The Lines (556) in the Lines Class of the Network Analyst window indicates that 556 out of 713 villages (77.9%) are within a 10 km distance of an optimum school location (facility). Therefore, a total of 157 villages have not been allocated to an optimum school location (facility).

Now you will inspect the results in more detail.

**Step 2:** In the Table Of Contents, right-click the Facilities sublayer and choose Properties

**Step 3:** From Layer Properties select Symbology

**Step 4:** Uncheck the tick mark under Symbol (next to red symbol)

**Step 5:** Click where Value = 1.0 and hold the shift key. Select values 1.1, 1.2, 1.3, 0.0, 0.1 and 0.2

**Step 6:** Click Remove

**Step 7:** Click OK.

Your symbology tab should look like the following graphic:
Step 8: Highlight the green symbol for Chosen (chosen optimum locations) and change the color to bright red:

- Click **Apply** and then **OK**

Step 9: Uncheck the tick marks for Point Barriers, Line Barriers and Polygon Barriers

Your ArcMap screen should look like the following graphic:
Step 10: In the Table Of Contents, right-click the Demand Points sublayer and choose Properties

Step 11: From Layer Properties select Symbology

Step 12: Uncheck the tick mark under Symbol (next to red symbol) and delete the Error word under label. There are 2 villages that cannot be traversed but these will be included in the list of villages not allocated with a special symbol.

Step 13: Click where Value = 1.0 (Unlocated)

Step 14: Click Remove

Step 15: Click the symbol for Value = 1 (Located) and change the color to a bright yellow

Step 16: Click Apply and OK.

Your symbology tab should look like the following graphic:
Step 17: In the Table of Contents, right-click the Lines sublayer and choose Properties

Step 18: From Layer Properties select Symbology

Step 19: Change the green line symbol to a slightly darker symbol

Step 20: Click Apply and OK.

Your ArcMap screen should look like the following graphic:
It should be noted that it is possible to run Location-Allocation procedures using other criteria such as maximizing coverage and maximizing coverage with capacity constraints, and with various distance impedance constraints, by following the steps indicated in sections 5.2 to 5.6. This is exactly the process followed to generate alternative scenarios of location-allocation outputs for the Research Paper.

9.8 **Determine the existing schools located within proximity of the optimum locations of new schools**

The following procedures provide answers to question 11 on page 5 of the Manual.

Using the map generated above for the 23 optimum locations solution, apply the following steps:

1. Export the 23 optimum locations (facilities) to a new GIS layer and add the layer to the map.

**Step 1**: In the Table Of Contents, right-click the Facilities sublayer and choose Open Attribute Table.

**Step 2**: From the Table options, go to Select by Attribute

**Step 3**: In the Select by Attribute dialog box under attributes, double-click “Facility Type”. This appears in the window below the dialog box. Set Facility Type = 3 (a code of 3 means Chosen – the 23 chosen facilities).

Your ArcMap screen should look like the following graphic:
Step 4: You will notice that the 23 optimum locations (facilities) are highlighted in blue on the map and also shown in the attribute table.

Step 5: Close the Select by Attribute dialog box and the Attribute Table.

Step 6: In the Table of Contents go to the Facilities sublayer and right click. Go to Data > Export Data and export the layer to a .SHP file in the \BAKSA\ directory.

Step 2: In the Export Data window ensure Selected Features is present, use the same coordinate system as this layer’s source data

Step 3: Give a name for the output file: Facilities

Step 4: Click OK

Step 5: When asked do you want the new layer to be added to the map window, say yes.

Step 6: In the Table of Contents go to the Facilities sublayer and uncheck the box to the left of the layer name.

Step 7: Go to the new layer Facilities and double-click the standard symbol set by ArcMap for the Facilities point layer. Select another more appropriate symbol and increase the size of the symbol.

Step 8: Go to the Govt. Secondary School layer and change the symbology to that which represents a school.

Your ArcMap screen should look like the following graphic:
Your next objective in order to answer the question is to determine the number of schools that are located within a fixed distance from the 23 optimum facility locations. In this example we will use a fixed distance of 2 km and then a fixed distance of 5 km.

**Step 9:** Go to the ArcMap menu option sat the top of the screen and choose Select by Location from the drop-down list. Here you will select features in the Govt. school layer (target layer) that are located within a fixed distance of the source layer – the Facilities.

**Step 10:** In Select by Location dialog window, check Govt. Sec Schools as the Target layer. Ensure Facilities is checked as the Source layer. Under ‘Spatial selection method for target layer feature(s):’ specify ‘are within a distance of the source layer feature’. Select kilometer as the distance unit and type 2.0 to the left (a fixed distance of 2 km).

Your ArcMap screen should look like the following graphic:
Step 11: Note that the selected Govt. secondary schools that meet the criteria are highlighted in blue on the map window. To determine how many schools meet the criteria Go to the layer name, right click and open the Attribute Table for schools. At the bottom of the attribute table will be indicated how many of the 147 government secondary schools meet the 2 km distance criteria. In this case 15 out of 147 schools meet the criteria.

Step 12: From the map window one can count the number of Facilities which have a school located within a 2 km distance; in this case 11 out of 23 Facilities have 15 secondary schools located within a 2 km radius.

Step 13: The same procedures as in Steps 9-11 can be used to determine the number of secondary schools within a 5 km distance of a Facility. Remember to clear your initial selection before you run this step.

Your ArcMap screen should look like the following graphic:
10. Generating statistical output – accessibility characteristics

The following procedures use the attributes of the sublayers under Location-Allocation to generate the statistical outputs that enable an evaluation of the optimum location-allocation solution and comparison with other solutions when available.

The statistical outputs are referred to as Accessibility Characteristics (see Table 4) of the solution as they summarize such elements as average distance, maximum distance, size of catchment areas, total population served, average number of villages per catchment area, average population of a catchment area, total person-kilometers travelled and average population density of a catchment area, etc. The Accessibility Characteristics outputs provide answers to question 11 on Page 5 of the Manual.

In the following pages of the manual, you will be shown how to calculate the various accessibility characteristics shown in Table 4 where the location-allocation problem is to determine 23 optimal facility locations such that they minimize average distance within a 10 km distance constraint to villages. These statistics are shown in the yellow column.
Table 4 System-wide accessibility characteristics: 23 optimal secondary school locations (Minimizing average distance)

<table>
<thead>
<tr>
<th>Accessibility characteristics</th>
<th>Minimizing Average Distance* (Size=520)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No Distance Criteria</td>
</tr>
<tr>
<td>Average distance travelled</td>
<td>3.9</td>
</tr>
<tr>
<td>Maximum distance travelled</td>
<td>10.2</td>
</tr>
<tr>
<td>Number of villages covered</td>
<td>678</td>
</tr>
<tr>
<td>Percent of persons aged 14-15 covered</td>
<td>96.9 (11,599)</td>
</tr>
<tr>
<td>Average number of villages per catchment area</td>
<td>29.4</td>
</tr>
<tr>
<td>Average number of persons aged 14-15 per catchment area</td>
<td>504</td>
</tr>
<tr>
<td>Average population of villages per catchment area</td>
<td>39,221</td>
</tr>
<tr>
<td>Average population density per catchment area (p.m.)</td>
<td>541.9</td>
</tr>
<tr>
<td>Average size of catchment area (sq. km)</td>
<td>101.2</td>
</tr>
<tr>
<td>Total weighted cost: person-kilometers travelled</td>
<td>43,241</td>
</tr>
</tbody>
</table>

*Physical barrier constraints were also included in the objective function.

10.1 Average distance and maximum distance

In the Table of Contents, right-click the Lines sublayer and choose Open Attribute Table. This table contains one record for each demand point allocated to a facility. It also lists the shortest path impedance between the two locations and the weight captured by the facility. To calculate average distance between allocated villages (from the centroid) to the 23 optimum locations (government secondary schools) do the following:

- Using your mouse, click on the attribute Total_Length; this highlights the column in blue
- Right click on Total_Length and go down to select Statistics, then click
ArcMap automatically generates summary statistics for all of the attributes in the open attribute table.

Under Field you see TotalLength. The average distance is given in meters – 5,496.10 meters. This is equivalent to 5.5 km.

The maximum distance is given as 9,971.5 meters or approximately 10 km – this was the maximum distance constraint used in the location-allocation solution.

### 10.2 Person-kilometers travelled

- The column next to TotalLength is TotalWeightedLength which represents, for each village, the cost of moving the demand (estimated person aged 14-15 in 2016) by the distance from the village centroid to the respective optimum location. This is calculated for every village that is allocated to an optimum location.
- Under Field, click the down arrow and select TotalWeightedLength. The sum value of 52,695,186.7 meters is equivalent to 52,695 person-kilometers travelled in the solution.

### 10.3 Percent of persons aged 14-15 covered by the solution

The attribute table for Lines lists the weight captured by each respective facility (optimum location). The number of persons aged 14-15 in 2016 actually reached by the 23 optimum location solution, and corresponding optimum allocations, is contained in the summary statistics for the Weight column.

- Under Field, click the down arrow and select Weight. The sum value of 10,032 is the total number of persons aged 14-15 in 2016 captured by all 23 optimum locations.
- This value represents 83.9% of the total number of persons estimated to be aged 14-15 in 2016 (a total of 11,958 persons aged 14-15).
10.4 Average number of villages per catchment area

The attribute table of the Lines layer contains one record for each demand point allocated to a facility. There are two methods for calculating the average number of villages per catchment area:

- Divide the total number of Lines (n=556) by the number of catchment areas (23) – one for each optimum location. The result is an average of 24.1 villages per catchment area.
- Use the FacilityID field in the attribute table. The FacilityID field lists the ID of each optimum location to which a village has been allocated. So if 39 villages are allocated to FacilityID 226, the number 226 is repeated in the column 39 times.
- To determine the count of the number of villages allocated to each optimum location (FacilityID) and determine the average do the following:
  - Right click on FacilityID and go down to select Summarize, then click
  - The Summarize screen appears with FacilityID selected as the field to be summarized. Other fields are also summarized.
- An output table will be created with the results Sum_Output.dbf. Click Ok.
- ArcMap asks if you would like the table added to the Table of Contents. Click Yes.
- Go to the Table of Contents, scroll down to Summary_Output.dbf.
- Right click Summary_Output.dbf and examine the two fields FacilityID and Count_FacilityID.
- There are 23 records in Summary_Output.dbf – one for each facility.
- The Count_FacilityID field lists the number of villages allocated to each facility separately.
- Calculate the average number of villages per catchment area (facility) by generating Statistics on Count_FacilityID. The result is 24.1 villages per facility (catchment area).
- The maximum distance is given as 9,971.5 meters or approximately 10 km – this was the maximum distance constraint used in the location-allocation solution.

![Image of ArcMap showing the Summarize window and the Table of Contents]
10.5 Average number of persons aged 14-15 per catchment area

This is equivalent to the total number of persons aged 14-15 in 2016 captured by the 23 optimum location solution divided by the number of facilities located (n=23).

The result is an average of 436 persons aged 14-15 in 2016 per catchment area.

10.6 Average population of villages per catchment area

The information required to calculate this average value is contained in two separate layer tables in the Table of Contents – the Lines sublayer of Location-Allocation and the Villages_Points layer.

The Lines sublayer of Location-Allocation contains the DemandID of every village allocated to a FacilityID. This layer must be exported as a Shape file and added to the Table of Contents before the attribute table can be joined to that of Villages_Points:

- In the Table Of Contents, right-click the Lines sublayer and choose Data > Export Data
- In the Export Data window ensure All Features is present, use the same coordinate system as this layer’s source data
- Give a name for the output file: I have called it 556Lines
- Click OK
- The 556Lines shape file layer is added to the Table of Contents.
- Uncheck the layer to turn off the symbol for 556Lines.

The Villages_Points layer attribute table contains the total population of each village, together with the calculated density of population of each village and so on.

To link these two attribute tables, one requires a common ID (although the field name can be different in both files). Use the following procedure to do a table join between two layers:

- In the Table Of Contents, right-click the 556Lines layer and choose Joins and Relates > Join
- Click on Join. The Join Data windows open up.
• Ensure that what you want to join to this layer is Join attributes from a table
• The field from this layer that the join will be based on is ObjectID.
• Search for the table to join to this layer. As it is in the Table of Contents, you should see the layer Villages_Points. Select this layer.
• Select the field in this table to base the join on: this field is called ID
• Select the button Keep Only Matching Records.

The Join Data window should look like the following graphic:

![Join Data Window](image)

• Click OK.

ArcMap joins the two tables. To view the joined tables, open the attribute table of layer 556Lines.
Please note that the DemandID from table in layer 556Lines matches, on a one to one basis, the ID from the table of layer Villages_Points.

- Find the attribute field TPOP_NEW and right click to run the Statistics on this field.

  - The sum of TPOP_NEW is 779,774
  - Divide the total population of the 556 villages by the number of catchment areas (n=23)
  - The average population of villages per catchment area is 33,903 (as per Table 1).

10.7 Average population density per catchment area

Using the same Statistics of 556Lines_Villages_Points as above:

- Click the down arrow under Field and scroll to the attribute field POPDEN_2
- Highlight the field – the statistics are automatically generated.
- The average density of population across the 23 catchment areas of 556 villages is 566.7 persons per sq. km.

10.8 Average size of catchment area

Using the same Statistics of 556Lines_Villages_Points as above:

- Click the down arrow under Field and scroll to the attribute field AREA_SQ_KM
- Highlight the field – the statistics are automatically generated.
- The total area of all 556 villages is 1801.6 sq. km
- Divide the total area by the 23 catchment areas of 556 villages
- The average size of catchment area is 78.3 sq.km.

Please note that the fields POPDEN_2 and Area_SQ_KM were previously calculated in the Villages_Boundaries layer, together with other new attributes. These calculated attributes were transferred across to the new layer Villages_Points when the Features to Point procedure were used in ArcToolBox.
10.9 Villages not allocated to an optimum facility

The attribute table for the Demand Points sublayer of Location-Allocation contains a field called AllocatedWeight that lists the weight assigned to every village that has been allocated to an optimum facility. Those villages that have not been allocated have a NULL for the AllocatedWeight.

You can select the NULL entries and export them as a separate layer to be added to the Table of Contents:

- Click on Demand Points to highlight the layer name
- Right click and select Open Attribute Table
- In the tools for the Table click on Select by Attributes
- Double click AllocatedWeight to bring it down into the SQL window
- Click Is and click NULL – they both appear in the SQL window

- Your Select by Attributes window should look like the following graphic:
Click Apply
All rows (villages) where AllocatedWeight is NULL are highlighted in blue
At the bottom of the Table is written (157 out of 713 Selected)

To save these selected rows of the table as a GIS layer, do the following:
- In the Table Of Contents, right-click the Demand Point sublayer and choose Data > Export Data
- In the Export Data window ensure Selected Features is present, use the same coordinate system as this layer’s source data
- Give a name for the output file: I have called it Not_Allocated
- Click OK
- Click Yes when asked Do you want to add the exported data to the map as a layer
- The Not_Allocated shape file layer is added to the Table of Contents.
- Change the symbol so that villages not allocated are clearly visible on the map (I have changed them to a blue circle).

11. Generating a layout and exported map

The final section of the user manual describes how to generate a professional layout in ArcMap that can be exported as a jpg file at high resolution for A4 or A3 printing.

It is recommended the user view the following YouTube video on ‘How to make a Layout’ in ArcMap: https://www.youtube.com/watch?v=M_de2Jaytiw

Please note that it is possible to print your saved Map_1.mxd file or to Export Map from File > Export Map. Then select the export format and resolution for the exported map.

In this section you will learn how to create a map product. Your map product will show the Baksa villages and the 23 optimum locations with allocations. You will also add several elements to your map like a north arrow and scale bar.

**Step 1: Specify the page setup for a map product**

In this step you will toggle to Layout view and prepare the page setup for a map product.

- Start ArcMap™. Go to File > Open and select Map_1
- Open the Map_1 map you created previously.
- Go to the top of the menu bar and Click View > Layout View.

(See graphic on Page 93)

Layout view appears along with the Layout toolbar. Layout view contains the virtual piece of paper where you can add map elements (such as north arrows, titles, legends, and scale bars) to your map. The Layout toolbar contains tools for navigating the virtual piece of paper. Be careful when navigating your map and layout. The Tools toolbar contains tools for navigating the data on your map. The Layout toolbar contains tools for navigating the entire piece of paper. You can also control the page size, orientation, and margins of your virtual piece of paper.
• Click File > Page and Print Setup. I have selected a Brother MFC printer that can print A3 size.
If necessary, uncheck ‘Use Printer Paper Settings’ [or ‘Same as Printer’].

If you plan on giving your map documents to other users, it is important to uncheck the Same as Printer box. If other users are not connected to your printer, they will get a printer error opening the map. Also, if your map is larger than their printer’s page size, it will appear completely off the page in the Layout view.

Next you will change the orientation of the page.

• In the Map Size area, for Page Orientation, click Landscape.
• Click OK.

Now you will make room for other map elements on the page.
Resize and position the data frame so there is room for a title along the top and other map elements along the right side.
Step 2: Insert map elements

Map elements include north arrows, legends and scale bars, etc. You will add some of these to your page to create a map product.

First you will add a title.

- Click Insert > Title.
- Type **Optimal Location of 23 Secondary Schools (Minimizing Average Distance within 10 km)**
If you made a mistake, you can double-click the title to access its properties. You can use the Properties dialog to set a variety of properties for the title. Next you will change the size of the title text.

- Close the Properties dialog (if necessary).
- On the Drawing toolbar, for Font Size, type 24 and press BOLD and Enter. Make sure the left edge of the title lines up with the guide you added earlier.

Next, you will add the legend.

- Click Insert > Legend. Move the legend to the right side of the map.

Currently, the legend displays symbols for all visible layers in the map including the image. You are only using the image to improve the visual effect, so you will remove the image symbols from the legend.

- Double-click the legend to access its properties.
- Click the Items tab
  - For Legend Items, select all the legend items.

- You can click the Left arrow to remove any Legend Items.
- Click OK.
- Reposition the legend, if necessary.

Next you will add a scale bar.

- Click Insert > Scale bar.

Before the scale bar is added to the map, you will need to specify some initial properties.

- Under Units select Kilometers. Click OK.

ArcMap will automatically choose properties for the scale bar, but you can change the properties to create the best scale bar for your map. First, move the scale bar, then zoom in on the scale bar so you can see it better.

- You can change the label for Chosen Facilities to be Optimal Locations by clicking on Chosen under the Facilities sublayer in Location-Allocation. Click again to enable a change of the label, Type Optimal Locations.
- Use the same method to change the label for the Lines Sublayer to Allocated Villages.
- These changes will be automatically updated on the map and on the layout.

Your layout should appear as the following graphic:
• Next go to File > Export Map
• Type Baksa_Layer as the name under which to save the file
• Select JPEG as the Save as Type
• Select 160 as the resolution (if you increase the resolution you will also increase the size of the jpg file)
• Click OK.
References


APPENDIX 1

Procedure to Download and Install a Trail Version of ArcGIS 10.3.1

The ArcGIS software that has been used to undertake the location-allocation analysis, plus other analyses and generation of map outputs is available for a 60 day trial period from ESRI India at the site indicated below. Follow the procedures listed below:

1. Open a web browser and type in the web address of ESRI India shown below:

   http://www.esri.in/products

2. Click on ArcGIS for Desktop. The following screen appears.
3. In the above screen, click on Free Trial. Next you will see the following screen that provides information on what is included in a free trial and that you need to sign up for a free trial.
You will be sent, by email, details of the account that would have been set up for you and download instructions together with installation instructions.

4. Information about what happens at the end of the trial and Technical Requirements are shown and then at bottom of the screen (as below):

What Happens at the End of the Trial?

Once you purchase ArcGIS for Desktop (which includes ArcGIS Online) at the end of your trial, all the work you’ve saved in ArcGIS Online during the trial becomes part of your account. You won’t lose anything you have built!

Please note: Trial subscriptions from multiple individuals and the content they create during the trial cannot be merged into a single organizational subscription.

If you want to try ArcGIS for Desktop with ArcGIS for Server, give us a call at 1-800-447-9778 FREE.

Technical Requirements

ArcGIS Pro requires Microsoft .NET Framework 4.5 and Microsoft Internet Explorer version 8 or newer. Before running the installation program for ArcGIS Pro, ensure that your machine meets these prerequisites. Quick start for ArcGIS Pro provides an overview of installing and setting up ArcGIS Pro and links to detailed resources, including system requirements.

ArcMap requires Microsoft .NET Framework 3.5 SP1 and Microsoft Internet Explorer version 7 or newer. Before running the installation program for ArcMap, ensure that your machine meets these prerequisites. The quick start guide provides an overview of installing and setting up ArcMap and links to detailed resources, including system requirements.

5. The above Technical Requirements are very general but your laptop must have Microsoft .NET Framework 4.5 or above installed together with Internet Explorer version 8 or newer. You should start with the ArcGIS 10.3.1 quick start guide:
6. It is important to look at what is included with the download:

What’s included

ArcGIS 10.3.1 for Desktop includes the following components:

- **ArcGIS Uninstall Utility** - Utility to assist in removing ArcGIS products prior to 10.1 in preparation for installing ArcGIS 10.3.1.
- **ArcGIS for Desktop** - Installation for Basic, Standard, and Advanced editions of ArcGIS for Desktop and optional ArcGIS extension products.
- **ArcGIS for Desktop Background Geoprocessing (64-bit)** - Installation for background geoprocessing in 64-bit.
- **Database Server (Desktop)** - Installation for SQL Server Express instance to store geodatabases.
- **ArcGIS License Manager (Windows and Linux)** - This version is required to run ArcGIS 10.3.1 for Desktop and Engine with Concurrent Use licensing. It also supports all other ArcGIS 10.x Concurrent Use releases.
- **ArcReader** - Desktop mapping application that allows users to view, explore, and print maps and globes.
- **ArcGIS Tutorial Data for Desktop** - Data used with ArcGIS Desktop tutorials.

Additional licensed extensions available as separate downloads:

- **ArcGIS Data Interoperability for Desktop** - Enables ArcGIS to read and process over 115 GIS and CAD formats supported by Safe Software’s FMQ.
- **ArcGIS Data Reviewer for Desktop** - Provides tools to manage quality control and makes data quality a component of your overall data management strategy.
- **ArcGIS Workflow Manager for Desktop** - Application for defining and executing processes, configuring workflow and managing resources to suit your business needs.
7. If you will be upgrading to ArcGIS 10.3.1 then the following screen image is relevant. As regards
software authorization numbers, you will be sent information about how to activate these in the
email that contains installation instruction:

Upgrading to ArcGIS 10.3.1

- The ArcGIS 10.3.1 setup package is designed to detect and upgrade an existing installation of the same ArcGIS
  product. The settings for the installation location, license manager (for Concurrent Use), or authorization
  information (for Single Use) are retained in the upgrade. See the installation guide for more information on
  installation upgrades, new installations, or installations over versions prior to 10.1, which are not supported by the
  upgrade process.
- Existing ArcGIS 10.1-10.3 authorization numbers will work with ArcGIS 10.3.1.
- **ArcGIS 10.3.1 for Single Use:** if ArcGIS 10.3.1 will be installed on a machine that is different from where a previous
  ArcGIS 10.x product is currently installed and you wish to use the existing ArcGIS 10.1 - 10.3 authorization number
  for ArcGIS 10.3.1, the previous ArcGIS 10.x product must first be deauthorized before authorizing ArcGIS 10.3.1.

Obtaining software authorization numbers

If needed, your account’s primary maintenance contact can obtain authorization numbers from the My Esri site. After
signing in with your Esri Account, click My Organizations > Licensing > Authorizations. Click a product name to
obtain its authorization number. You can also click on ‘Show Filter Options’ and type in the name of the product.

The license version on authorizations eligible for use with ArcGIS 10.3.1 will display as 10.1 – 10.3.1 under
Authorizations. For those outside the United States, contact your local distributor for information about your
authorization numbers.

8. Please read the ArcGIS 10.3.1 system requirements and ensure that your laptop meets the criteria
for one of the operating systems mentioned in the following screens:

ArcGIS 10.3.x for Desktop system requirements

- ArcGIS Desktop supported platforms
- Hardware requirements
- Software requirements
- Software required to connect to a DBMS
- Developer SDK requirements
- Operating system requirements and limitations

Visit Esri Support for information on earlier versions.
**ArcGIS Desktop supported platforms**

Check your computer’s ability to run ArcGIS

<table>
<thead>
<tr>
<th>Operating Systems</th>
<th>Minimum OS Version</th>
<th>Maximum OS Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10 Home, Pro, and Enterprise (32 bit and 64 bit [EM64T])**</td>
<td>Update: April 2014</td>
<td></td>
</tr>
<tr>
<td>Windows 8.1 Basic, Pro and Enterprise (32 bit and 64 bit [EM64T])</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 8 Basic, Pro and Enterprise (32 bit and 64 bit [EM64T])</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 7 Ultimate, Professional and Enterprise (32 bit and 64 bit [EM64T])</td>
<td>SP1</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2012 R2 Standard and Datacenter (64 bit [EM64T])</td>
<td>Update: April 2014</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2012 Standard and Datacenter (64 bit [EM64T])</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server 2008 R2 Standard, Enterprise and Datacenter (64 bit [EM64T])</td>
<td>SP1</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2008 Standard, Enterprise and Datacenter (32 bit and 64 bit [EM64T])</td>
<td>SP2</td>
<td>SP2</td>
</tr>
</tbody>
</table>

* See the Operating system requirements and limitations section for additional requirements and information.
## Hardware requirements

<table>
<thead>
<tr>
<th></th>
<th>Supported and Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU Speed</strong></td>
<td>2.2 GHz minimum; Hyper-threading (HHT) or Multi-core recommended</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td>x86 or x64 with SSE2 extensions</td>
</tr>
<tr>
<td><strong>Memory/RAM</strong></td>
<td>2 GB minimum</td>
</tr>
<tr>
<td><strong>Display properties</strong></td>
<td>24-bit color depth</td>
</tr>
<tr>
<td><strong>Screen resolution</strong></td>
<td>1024 x 768 recommended minimum at normal size (96 dpi)</td>
</tr>
<tr>
<td><strong>Swap space</strong></td>
<td>Determined by the operating system; 500 MB minimum.</td>
</tr>
<tr>
<td><strong>Disk space</strong></td>
<td>2.4 GB</td>
</tr>
<tr>
<td></td>
<td>In addition, up to 50 MB of disk space may be needed in the Windows System directory (typically, C:\Windows\System32). You can view the disk space requirement for each of the 10.3 components in the Setup program. If using ArcGlobe, additional disk space may be required. ArcGlobe will create cache files when used.</td>
</tr>
<tr>
<td></td>
<td>64 MB RAM minimum, 256 MB RAM or higher recommended. NVIDIA, ATI, and Intel chipsets supported.</td>
</tr>
<tr>
<td><strong>Video/Graphics adaptor</strong></td>
<td>24-bit capable graphics accelerator</td>
</tr>
<tr>
<td></td>
<td>OpenGL version 2.0 runtime minimum is required, and Shader Model 3.0 or higher is recommended.</td>
</tr>
<tr>
<td></td>
<td>Be sure to use the latest available driver.</td>
</tr>
<tr>
<td><strong>Networking Hardware</strong></td>
<td>Simple TCP/IP, Network Card, or Microsoft Loopback Adapter is required for the licence manager.</td>
</tr>
</tbody>
</table>
Software requirements

- .NET Framework 3.5 SP1 must be installed prior to installing ArcGIS for Desktop.
- Internet Explorer requirement:
  Microsoft Internet Explorer (minimum IE 9) must be installed prior to installing ArcGIS for Desktop. Internet Explorer 9, 10 and 11 are supported.

- Python requirement for Geoprocessing:

  ArcGIS for Desktop geoprocessing tools require that Python 2.7.x and Numerical Python 1.7.x are installed. If the ArcGIS for Desktop setup does not find either Python 2.7.x or Numerical Python (NumPy) 1.7.x installed on the target computer, Python 2.7.x and Numerical Python 1.7.1 will be installed during a complete installation of ArcGIS 10.3.x. You can choose a custom installation to unselect the Python feature and avoid installing it. Additionally, if the Python setup is executed during the ArcGIS for Desktop installation, you will be provided with the opportunity to choose its installation location. The Python installation location should not include spaces.

Printer support

ArcGIS supports printing to any Microsoft certified Windows printer using the native driver in ArcGIS. Note that some printer drivers do not support complex maps, and the ArcPress printer driver or additional hardware may be needed for these complex maps.

9. It is also worth your while to read the ‘Operation system requirements and limitations’ section, especially if you have a laptop with the Windows 10 operating system. Below is the screenshot for the Windows operating system:

The Windows 10 technical article indicates that ArcGIS Desktop 10.3.1 is certified for Windows 10.